DATA ACQUISITION AND PROCESSING REPORT

SPOT (s3004)
Team Leader: Lieutenant Junior Grade Briana Welton, NOAA

Applicable Surveys

M-H910-NRT7-07
H11658
WESTERN SAMBOS, KEY WEST, FL

OPR-E300-BH/NRT7-07
H11693
POTOMAC RIVER INVESTIGATIONS, POTOMAC RIVER, VA & MD

S-E923-TJ-07
F00547
MAERSK TERMINAL, PORTSMOUTH, VA
A. Equipment

All survey data acquired by the Special Projects Operation Team (SPOT) were acquired with Survey Vessel s3004. Vessel s3004 has one sonar mounting arm on the starboard side of the vessel from which only one of the Unit’s three sonar systems—Reson 8125 multibeam echosounder (MBES), Klein Light Weight 5000 side scan sonar (SSS), or Benthos C3D phase-differencing bathymetric sonar (C3D)—are mounted at a given time. The dry hardware (Klein TPU, Reson 8P, and Benthos Server) are mounted in the cabin rack with all cables run such that changing sonar requires only exchange and connection of the transducer heads. The Odom CV vertical beam echosounder (VBES) is hull mounted near the center of rotation of the vessel.

The methods and systems described in this report are used to meet complete coverage and object detection coverage requirements and are in accordance with the OCS Hydrographic Surveys Specifications and Deliverables Manual (3/2007), Hydrographic Survey Directives, and the OCS Field Procedures Manual for Hydrographic Surveying (3/2007, v 2.1).

A.1. Echosounding Equipment

ODOM Echotrac CV Vertical-Beam Echosounder

The Odom Echotrac CV2 VBES is used as a single-frequency digital recording echosounder system with a digital recorder. The frequency settings range from 100 kHz to 1 MHz, though the normal operating frequency is 200 kHz. The manufacturer specifications of this sonar are included in Appendix I of this report.

The data is digitally recorded in meters as .bin files and Hypack files. The .bin files replace paper-trace records and can be viewed in Pydro Post Acquisition Tools. The Hypack files are converted to Caris HDCS data for processing. The Odom CV is primarily used simultaneously with either the Klein 5000 SSS or the Benthos C3D sonar.

The ODOM Echotrac CV2 is inappropriate for sole use in situations requiring complete coverage or object detection coverage. However, combined with SSS data, the ODOM Echotrac CV can be used to meet NOAA specifications for complete and object detection coverage.

RESON SeaBat 8125 Multibeam Echosounder

The Reson SeaBat 8125 MBES is a single-frequency, digital-recording MBES with an operating frequency of 455 kHz. The RESON 8125 transducer consists of a flat transmitter array and solid cylindrical receiver array installed on a manually deployable arm off the starboard side of vessel s3004.
The Reson 8125 forms 240 beams each of which has a 0.5° across-track beam footprint for a maximum total swath width of 120°. Each beam has an along-track resolution of 1°. The ping rate is nominally 20-40 Hz, but may vary according to operating conditions. The Reson 8125 sonar is capable of bottom detection in depths from 3-120m. Specifications for this sonar are included in Appendix I of this report.

The Reson 8125 performs active beam steering to correct for sound speed at the transducer head using a surface sound speed sensor. This sensor is discussed in the Sound Speed Equipment section of this report. Real-time attitude data from the vessel’s Applanix POS-MV attitude sensor is also input to the Reson 8125 to aid beam steering, though attitude correction is performed post-acquisition in Caris HIPS. The Applanix POS-MV attitude sensor is discussed in the Positioning and Orientation Equipment section of this report.

Reson 8125 data are acquired in meters using Isis XTF format. In addition to bathymetry, Reson “Snippets” and side scan data are also recorded in the XTF file. Reson “Snippets” and side scan data are not routinely used to generate charting products and are archived for second party scientific purposes such as sea bottom characterization, fish habit studies, or geological studies. Reson 8125 user parameters and surface sound speed are also recorded within the XTF file.

**Benthos Light Weight C3D Side Scan/ Bathymetry System**

The Benthos C3D is a phase-differencing bathymetric sonar that uses the CAATI (Computed Angle of Arrival Transient Imaging) Algorithm patented by Simon Frasier University to solve for multiple angles of arrival to achieve a wide swath of high resolution bathymetry and imagery. The system consists of a C3D light weight towfish, a processor and a computer for a user interface. The specifications of the Benthos C3D are included in Appendix I of this report.

---

1 An Odom Digibar is used aboard vessel s3004 for this purpose.
The C3D acquires both SSS imagery and bathymetric data, both of which are recorded in a single Isis XTF file. A real-time surface sound speed input from the Odom Digibar is used during acquisition.

The Benthos C3D is under evaluation by the NOAA Office of Coast Survey; the bathymetry is not currently used for charting purposes. However, gridded surfaces are created to analyze generalized bathymetry. Odom CV VBES data is acquired in conjunction with Benthos C3D bathymetric and imagery data and used as the sole source of bathymetry for charting purposes.

**A.2. Acoustic Imaging Equipment**

**KLEIN 5000 High-speed Side Scan Sonar**

The lightweight Klein 5000 high-resolution side-scan sonar system is a digital-recording, beam-forming acoustic imagery device with an operating frequency of 455 kHz and vertical beam angle of 40°. The Klein 5000 system consists of a Klein towfish, a Transceiver/Processing Unit (TPU), and a computer for user interface.

The Klein 5000 system is distinct from other commercially-available SSS in that it forms five simultaneous, dynamically-focused receiver beams per transducer face to improve along-track resolution. The along-track resolution is approximately 30cm at the 100m range scale, even when acquiring data at speeds up to 10 knots. Across-track resolution is typically 7.5cm at the 100m range scale. The achievable 0.3m resolution meets the OCS Hydrographic Surveys Specifications and Deliverables Manual for object detection. Triton Isis is used to acquire data with the Klein 5000 SSS.

**A.3. Manual Sounding Equipment**

Vessel s3004 does not possess manual sounding equipment such as a sounding pole or a lead line.

**A.4. Positioning and Orientation Equipment**

Vessel s3004 uses an Applanix POS-MV 320 Version 4 inertial positioning and orientation system along with U.S. Coast Guard Differential GPS (DGPS) for a highly accurate blended position and orientation solution.
Vessel s3004 is equipped with a Trimble DSM132 DGPS receiver. The DSM132 includes a GPS receiver capable of receiving external RTCM correctors from a shore-based reference station. The system outputs position information once per second. Best expected position accuracy with the DSM132 system is less than one meter with 5 or more space vehicle vectors in the solution.

The POS/MV 320 includes dual GPS antennas, an inertial measurement unit (IMU), and data processor (PCS). The IMU measures linear and angular accelerations corresponding to the major motions of the vessel (heave, pitch, roll) and inputs this data to the PCS, where it is combined with a GPS position determined by carrier-phase differential measurements to give the final position solution. Heading is calculated using a GPS-azimuthal measurement system (GAMS); two offset GPS receivers mounted on the cabin of the vessel input to the PCS.

The blended DGPS and inertial position/orientation solution has typical values of 0.02° true roll and pitch accuracy, 0.02° heading accuracy, 2m position accuracy, and 0.03 ms⁻¹ speed accuracy. These parameters are monitored in real time during acquisition using the POS/MV user interface software, PosView. These values meet the position accuracy standard for an IHO Order 1 survey.

Vessel s3004 is set up according to the “Precise Timing” method, a sonar acquisition configuration which applies a time stamp at the point of acquisition to all incoming sonar, attitude, and positioning data. The timing message is generated by the POS/MV and synchronizes the sonar system time with the POS/MV UTC time.

Although “Precise Timing” reduces the effect of time latency on MBES data, corrections for residual time latency biases must still be made via a patch test.

POS-MV True Heave files (.000) are also recorded during bathymetric data acquisition and applied in Caris HIPS/SIPS during post processing.

A.5. Sound Speed Profilers

Sea-Bird SBE19+ CTD Profiler

Vessel s3004 acquires water column sound speed data using a Sea-Bird Electronics SeaCat SBE19+ Conductivity-Temperature-Depth (CTD) profiler. Temperature is measured directly. Salinity is calculated from measured electrical conductivity. Depth is calculated from strain gauge pressure. The SBE19+ is capable of CTD profiling at depths from 0-350m. The SBE19+ is deployed by hand over the side of vessel s3004.

Further documentation on Precise Timing may be found in Appendix III of the 2007 Field Procedures Manual.
The CTD was returned to the manufacturer for calibration January 2007. Calibration documents are contained in Appendix IV of this report.

**SEA SURFACE SOUND VELOCIMETERS**

Vessel s3004 uses an Odom Digibar Pro for surface sound speed input to the Reson 8125 and C3D. Unlike the CTD profiler, sea surface sound speed is calculated using two-way travel time. A pulse of known frequency is emitted and reflected off a surface. The two-way travel time is measured over the known distance between the transmitter and reflective surface, from which the sound speed is then calculated.

**ODOM HYDROGRAPHIC SYSTEMS DIGIBAR PRO**

The Digibar Pro is a real-time time-of-flight sea surface sound velocimeter. The manufacturer specified sound speed accuracy is 0.3 ms\(^{-1}\). Aboard vessel s3004 the Digibar probe is mounted to top of the deployable sonar arm plate, below which the Reson 8125 or the C3D are mounted. Data are sent in real time to the Reson 8P or Benthos C3D server.

The Digibar Pro has not been calibrated since it was purchased in 2005.

**B. SOFTWARE SYSTEMS**

**B.1 ACQUISITION SOFTWARE**

**HYPACK MAX**

Hypack Max is a multi-function marine survey software package. Hypack Max is used for vessel navigation and for acquisition of VBES data and detached positions. Survey lines, vessel position with respect to lines, and various navigation parameters are displayed for the helmsman. Hypack also controls Isis data logging on the acquisition computer through the NOAA Delph string, allowing XTF files to be named by their Hypack line file name.

**TRITON IMAGING ISIS**

Isis is a Windows-based acquisition software package that provides real-time data display and sonar control. Isis is used to acquire Klein 5000, Reson 8125 and Benthos C3D data in XTF format. The Isis setup is configurable for each type of sonar and allows the user to save the configuration files so that they are automatically launched during start-up.
The same computer is used for SSS and MBES acquisition. A separate computer is used for C3D data acquisition, which was provided with the C3D system. Data acquisition is monitored real-time by a qualified sonar operator.

The primary user settings that are adjustable during SSS acquisition are the range scale and the resolution. Typically, the range scale and resolution are set prior to logging data and not changed again until the surveyed depth area changes.

The primary adjustable user settings during MBES acquisition are transmit power, range, gain, pulse length, ping rate, spreading, and absorption. Typically, power, range, and gain are the only settings that are adjusted dynamically during the logging of a line file (power and gain sparingly). The pulse length, spreading, and absorption are set for the survey depth area and are rarely adjusted. The ping rate is set to its maximum because the Reson 8125 will only use the highest possible ping rate for the vessel speed and depth at any given time.

### B.2. Processing Software

**CARIS HIPS/SIPS v 6.1**

Caris HIPS/SIPS (Hydrographic Information Processing System/ Side-scan Information Processing System) is used for processing, correcting, and analyzing all bathymetric, side scan, and phase-differencing bathymetric sonar data.

Caris HIPS is used for converting, correcting, cleaning, and analyzing gridded bathymetric data. Caris SIPS is used for converting and correcting side-scan sonar imagery and for contact selection and mosaic generation. Phase-differencing bathymetric sonar XTF files are processed in Caris as both bathymetric and side scan data files.

**HSTP PYDRO**

Pydro is a proprietary program developed and maintained by NOAA’s Hydrographic Systems and Technology Program (HSTP), and is used primarily for feature management. Multibeam contacts (designated soundings), SSS contacts, and detached position are analyzed, grouped, and assigned S-57 classifications. Weighted grids (Caris surfaces) are imported into Pydro and excessed at survey scale for chart comparison. The Pydro Preliminary Smooth Sheet file (.pss) is delivered to the Atlantic Hydrographic Branch as part of the final submission package.

With the newest release of Pydro (v.7.x) the ability to process Tidal Constituents and Residual Interpolator (TCARI) tides has been implemented. If provided in the project instructions, the TCARI file for the area is loaded into Pydro along with the predicted, observed, or verified tide files for the corresponding stations. With this implementation,
tides are no longer processed within Caris HIPS. Further discussion of TCARI is found in the Water Level Corrections section of this report.

**HSTP Velocwin**

HSTP Velocwin is a proprietary program for the processing of sound speed casts. This program uses Sea-Bird Electronics SeaTerm and SBE Data Processing software to convert hexadecimal SeaCat data into ASCII conductivity-temperature-depth data, and then converts the ASCII data into a depth-binned sound speed file. The resulting SVP files are applied in Caris HIPS during post-processing to correct for sound speed variation within the water column. These sound speed files are applied to the data in Caris HIPS. Velocwin is also used to compare sound speed casts with its DQA function and to archive sound speed information for the National Oceanographic Data Center.

**MapInfo Professional 8.5**

MapInfo Professional is the Geographic Information System (GIS) software package used by SPOT. MapInfo is used for sheet management, line planning, final data analysis and creating end-user products such as chartlets and survey plots.

**C. Acquisition Methods**

The project instructions assigned to SPOT call either for 200% C3D, or Complete or Object Detection Coverage as defined in the FPM.

Where 200% C3D coverage is required, survey lines are planned such that outer beams cover the nadir beams of adjacent lines at set range scales, according to depth (generally 4 times the water depth for 200% coverage). Vertical beam echo sounder data is acquired simultaneously with C3D data acquisition and used as the sole source of bathymetric data for charting purposes.

Where 200% SSS with VBES is used to comply with object detection requirements, the C3D is used as the source of SSS data. Two SSS line plans (100% coverage and 200% coverage) are created using the range scales appropriate for the survey area. Line spacing for the first 100% coverage is 120m at the 75 meter range scale and 160m at the 100 meter range scale. The line spacing for the second 100% coverage line plan is identical to the spacing for the first 100%, and the first line of the second 100% coverage is offset by half the line spacing. Vertical beam echo sounder data is acquired simultaneously with C3D data acquisition and used as the sole source of bathymetric data for charting purposes.

When the project instructions require complete coverage, MBES lines are planned at a spacing of two to three times the water depth and acquired at a speed of three to four knots. The design of the sonar pole mount is the speed limiting factor for all other modes.
of acquisition. The maximum survey speed is around eight knots; otherwise water wake from the pole is forced over the gunwale of the vessel. All lines are run parallel to each other except cross lines.

**CROSS LINES**

Cross lines are acquired in accordance with the *OCS Field Procedures Manual* as a confidence check of the survey data. Survey lines are planned such that ten percent of the total linear nautical miles are cross lines. Cross lines are planned perpendicular to main scheme lines when survey area allows. Cross lines are compared to the product navigation surface in Caris HIPS 6.1. The results of the Cross line QC test are submitted in Separate V of the Descriptive Report of each project.

**D. CORRECTIONS TO ECHO SOUNDING AND QUALITY CONTROL**

**D.1. SOUND SPEED**

**SBE19+ Conductivity, Temperature and Depth (CTD) Profiler**

Sound speed profiles acquired with the Sea-Bird Electronics SeaCat SBE19+ CTD profiler are processed using the HSTP program Velocwin, which generates sound speed profile (SVP) files that are used to correct bathymetric HDCS data in Caris HIPS. Sound speed correctors are applied to MBES and VBES soundings during post processing.

The interval at which CTD casts are conducted depends on the data acquisition type, survey area and prevailing conditions. At a minimum, one CTD cast per week for VBES sound speed correction and one CTD cast every three to four hours for MBES acquisition is conducted. Casts are conducted more frequently when changing survey areas, or when survey conditions such as weather, tide, or current change sufficiently.

**D.2. WATER LEVEL CORRECTORS**

Soundings are initially reduced to Mean Lower-Low Water (MLLW) using predicted tides or preliminary (observed) zoned water level data. Data are obtained from the local, primary tide gauges through the Center for Operational Oceanographic Products and Services (CO-OPS) website (http://tidesandcurrents.noaa.gov/olddata). Predicted or observed water level files are converted to Caris tide files (.tid) and applied to all sounding data using either discrete tide zoning in Caris HIPS (.zdf files) or the TCARI module in Pydro if provided by CO-OPS.

After data acquisition is complete, a request for final, approved water levels is submitted to CO-OPS. Once final approved water levels are received, sounding data are re-corrected to MLLW using either the verified zones or the verified TCARI files.
D.3. TCARI

Starting with the 2007 field season, some projects require the use of the TCARI model for water level correction. Tidal Constituents and Residual Interpolator is a gridded interpolation algorithm that assigns appropriate water level time and phase offsets to echosounder data at each grid node.

If the use of TCARI files for water level correction is directed by the Project Instructions, then the Pydro TCARI tools found in Pydro 7.xx, are used to overwrite tide file in the HDCS line folder.

D.4. HEAVE, PITCH, ROLL AND HEADING, INCLUDING BIASES AND NAVIGATION TIMING ERRORS

Heave, pitch, roll, and timing bias values for vessel s3004 are determined during a patch test after a system is newly mounted on the sonar arm. Vessel offsets, dynamic draft correctors, and system bias values are entered in the sonar’s Caris Hydrographic Vessel Files (.hvf) and applied during Caris’ merge process.

D.5. VESSEL OFFSETS AND DYNAMIC DRAFT CORRECTORS

The vessel offsets were measured with a total station by the NOAA National Geodetic Service in Norfolk, VA, in the fall of 2005. The offsets are found in Appendix III of this report, and are also entered in the HVFs submitted with each survey. The dynamic draft values used for s3004 are those measured on s3002 (NRT5), an identical vessel. The dynamic draft values are entered in the HVFs submitted with each survey.

E. DATA PROCESSING AND QUALITY CONTROL

E.1. BATHYMETRY

Raw bathymetry data (XTF and Hypack) are converted into Caris HDCS data format upon completion of daily acquisition. Conversion parameters vary for each data format, and are stored in the LogFile of each HDCS processed line folder. After conversion, data are corrected with true heave, tides, and sound speed and then merged. Following merge, Total Propagated Error (TPE) is calculated.

For further explanation of TPE calculations refer to Section 4.2.1.1 of the 2007 OCS Field Procedures Manual (v. 2.2, March 2007).
**VERTICAL BEAM BATHYMETRY**

When VBES is the sole source of bathymetry (e.g. 200% SSS/C3D + VBES survey), VBES is converted to Caris HDCS and processed as described in the previous paragraph. The data is then examined and cleaned in Caris Singlebeam Editor. Digital records (.bin files) are used to provide extra information during data cleaning. The .bin files are viewed in Pydro Post Acquisition Tools. After the data has been processed and cleaned, an uncertainty-weighted BASE Surface is computed (usually at a resolution of five meters).

**MULTIBEAM BATHYMETRY**


When the primary source of bathymetry for a survey area is a combination of VBES and MBES, a collection of finalized CUBE surfaces is generated as the depth product of the survey. The data is examined and cleaned as necessary to reject gross fliers and to identify systematic data errors. Systematic errors are corrected or removed from the project, documentation of which is found in the survey processing notes or descriptive report. The surface names contain the resolution at which they were created, which is based on depth and data density.

When Complete or Object Detection MBES is the primary source of bathymetry, data are processed using CUBE. After computation of TPE, MBES lines are either used to create a new surface or are added to an existing surface. The resulting layers are analyzed by the data processor to identify fliers and/or systematic errors, and to identify significant bottom features. Fliers are rejected by the data processor in Caris Subset Editor (multi-line spatial view) or Caris Swath Editor (single-line time-series view). Systematic errors are identified and documented by the data processor. Least depths of navigationally significant features are flagged as “designated soundings,” which both identifies the object as a navigationally significant object for import into Pydro and forces the depth of the grid to match the least depth of the feature.

After data editing is complete, grids are finalized and combined for delivery to the Atlantic Hydrographic Branch. Surface resolution depends on depth and survey type (see OCS Hydrographic Specifications and Deliverables Manual for further information), and is specified in the name of the surface.

**E.2. IMAGERY**

After acquisition, SSS data are converted from XTF format to Caris HDCS format. Fish height, vessel heading (gyro), and vessel navigation records are then reviewed and corrected and recalculated. Data are then slant-range corrected to 0.1m with beam pattern correction. The slant-range corrected SSS imagery data are closely examined for
contacts. Imaged objects are evaluated for significance based upon apparent shadow length and appearance. Contacts are selected and saved to a contact file within the respective Caris HDCS line file and inserted into Pydro for feature management.

Two mosaics are created after SSS data have been processed; one of the first 100% of coverage and one of the second 100% of coverage (200%). If any deficiencies in the SSS coverage are found, a holiday line file is created from the mosaics, and additional lines of SSS are acquired.

**E.3. Bathymetry Analysis and Feature Classification**

Following data cleaning in Caris HIPS and SIPS, the following items are inserted into Pydro and saved in a Preliminary Smooth Sheet (PSS) file: finalized weighted bathymetry grids, SSS (C3D) contacts, MBES designated soundings, detached positions (DPs), Geographic Positions (GP), bottom samples (Hypack DPs), and AWOIS items. The Pydro .pss is used for survey analysis and feature management.

Images of contacts exported from Caris are displayed in the Image Notebook Editor in Pydro. Contacts are arranged by day and line and can be selected in the data “Tree” window. Information concerning a specific contact is reviewed in the Editor Notebook Window in Pydro. This information includes position, surrounding depths, contact cross references, and charting recommendations.

Each contact is reviewed, and information flags are set accordingly as described in the Pydro Data Flagging Decision Tree (Figure 4-22 in the *OCS Field Procedures Manual*). Contacts appearing significant are further investigated with MBES or VBES.

Multiple representations of one distinct feature (e.g. contacts from two or more SSS lines on a wreck) may be correlated together. For a group of correlated features, one representation is selected as the primary contact, and all others are selected as secondary contacts with respect to the primary contact.

After a feature is fully classified, primary features are flagged as “Resolved.” If a primary feature is flagged “Resolved,” then the secondary features correlated to that primary feature are automatically flagged “Resolved” and are given the same full classification as the primary feature.

After all items within the PSS have been resolved, three reports are generated for submission to the Atlantic Hydrographic Branch: Feature Report, AWOIS Report, and DTON report.

---

3 Contact selection includes measuring apparent height, selecting contact position, and creating a contact snapshot (*.tif) image.
4 Significant features are defined by the Hydrographic Survey Specifications and Deliverables as an object rising more than one meter above the seafloor in water depths of 0-20 meters, and an object rising 10% of depth above the seafloor in water depths greater than 20 meters.
E.4. Survey Deliverables and Ancillary Product Generation

All data are submitted digitally in close-keeping with section 5.1.2.2 the OCS Hydrographic Field Procedures Manuel; including raw and processed sonar data, ancillary correction data (tides, sound speed, true heave, hydrographic vessel files, etc), supporting products (Pydro PSS files, Caris sessions and field sheets); and all supporting reports and documentation.

The final bathymetric deliverable is a collection of gridded surfaces. Side scan sonar mosaics are also submitted as evidence of appropriate imagery coverage. These mosaics are also used to identify contacts, as well as general bottom type. Bathymetric surfaces and SSS mosaics are submitted in their respective Caris field sheets. In addition, the Pydro Preliminary Smooth Sheet (PSS) file is submitted as the record of survey feature management.

\footnote{Danger to Navigation (DTON) reports are generated immediately after discovery and are so submitted to the Marine Chart Division of the NOAA Office of Coast Survey. Multiple DTON reports during the course of a survey are possible. If no dangers are found during the course of a survey, no report is generated.}
E. Approval Sheet

As Team Leader, I have ensured that standard field surveying and processing procedures were utilized in accordance with the *NOS Hydrographic Manual, Fourth Edition; Field Procedures Manual*, and the *NOS Hydrographic Surveys Specifications and Deliverables*.

I acknowledge that all of the information contained in this report is complete and accurate to the best of my knowledge.

Briana Welton

LT(jg) Briana Welton, NOAA
<table>
<thead>
<tr>
<th>Equipment Type</th>
<th>Manufacturer</th>
<th>Model</th>
<th>Serial Number</th>
<th>Firmware and/or Software Version</th>
<th>Version Install Date</th>
<th>Date of last Calibration</th>
<th>Date of last Service</th>
</tr>
</thead>
<tbody>
<tr>
<td>Multibeam Echosounder</td>
<td>Reson</td>
<td>8125</td>
<td>31546</td>
<td>unknown</td>
<td>unknown</td>
<td>unknown</td>
<td>unknown</td>
</tr>
<tr>
<td>Side Scan Sonar</td>
<td>Klein</td>
<td>System 5000</td>
<td>Towfish 317, TPU 157</td>
<td>unknown</td>
<td>unknown</td>
<td>unknown</td>
<td>new</td>
</tr>
<tr>
<td>Interferometric Sonar</td>
<td>Benthos</td>
<td>C3D</td>
<td>40364</td>
<td>unknown</td>
<td>unknown</td>
<td>unknown</td>
<td>new</td>
</tr>
<tr>
<td>GPS Aided Inertial Navigation</td>
<td>Applanix</td>
<td>POS/MV 320 V4</td>
<td>2233</td>
<td>3.3.2.2</td>
<td>Nov-06</td>
<td>3/22/2007</td>
<td>none (new)</td>
</tr>
<tr>
<td>DGPS Receiver</td>
<td>Trimble</td>
<td>DSM132</td>
<td>224090080</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Attitude Sensor</td>
<td>Applanix</td>
<td>320</td>
<td>2233</td>
<td></td>
<td></td>
<td>3/22/2007</td>
<td></td>
</tr>
<tr>
<td>Sound Speed Profiler</td>
<td>Sea-Bird</td>
<td>SeaCat Plus Profiler</td>
<td>19P36399-4634</td>
<td></td>
<td></td>
<td>Mar-05</td>
<td>Mar-05</td>
</tr>
<tr>
<td>Surface Sound Velocimeter</td>
<td>Odom</td>
<td>Digitbar Pro</td>
<td>98350</td>
<td></td>
<td></td>
<td>new</td>
<td>n/a</td>
</tr>
<tr>
<td>Equipment Type</td>
<td>Manufacturer</td>
<td>Model</td>
<td>Serial Number</td>
<td>Firmware and/or Software Version</td>
<td>Version Install Date</td>
<td>Date of last Calibration</td>
<td>Date of last Service</td>
</tr>
<tr>
<td>----------------</td>
<td>--------------</td>
<td>-------</td>
<td>---------------</td>
<td>----------------------------------</td>
<td>----------------------</td>
<td>--------------------------</td>
<td>----------------------</td>
</tr>
<tr>
<td>GPS Backpack</td>
<td>Trimble</td>
<td>TSCe</td>
<td>31462</td>
<td>Terrasync Pathfinder???</td>
<td>7-Jan</td>
<td>none</td>
<td>none</td>
</tr>
</tbody>
</table>

**TIDES & LEVELING EQUIPMENT**

<table>
<thead>
<tr>
<th>Equipment Type</th>
<th>Manufacturer</th>
<th>Model</th>
<th>Serial Number</th>
<th>Firmware and/or Software Version</th>
<th>Version Install Date</th>
<th>Date of last Calibration</th>
<th>Date of last Service</th>
</tr>
</thead>
<tbody>
<tr>
<td>none</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**HORIZONTAL AND VERTICAL CONTROL EQUIPMENT**

<table>
<thead>
<tr>
<th>Equipment Type</th>
<th>Manufacturer</th>
<th>Model</th>
<th>Serial Number</th>
<th>Firmware and/or Software Version</th>
<th>Version Install Date</th>
<th>Date of last Calibration</th>
<th>Date of last Service</th>
</tr>
</thead>
<tbody>
<tr>
<td>GPS Backpack</td>
<td>Trimble</td>
<td>TSCe</td>
<td>31462</td>
<td>Terrasync Pathfinder???</td>
<td>7-Jan</td>
<td>none</td>
<td>none</td>
</tr>
</tbody>
</table>

**OTHER EQUIPMENT**

<table>
<thead>
<tr>
<th>Equipment Type</th>
<th>Manufacturer</th>
<th>Model</th>
<th>Serial Number</th>
<th>Firmware and/or Software Version</th>
<th>Version Install Date</th>
<th>Date of last Calibration</th>
<th>Date of last Service</th>
</tr>
</thead>
<tbody>
<tr>
<td>none</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Additional Information</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>------------------------</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>240 Beams</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1° x 0.5° Resolution</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Additional Information</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Roll/Pitch Accuracy: 0.05°</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Heave Accuracy: the greater of 5cm or 5% for periods of 20s or less</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Additional Information</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
SeaBat 8125

The SeaBat 8125 is the first wide-sector, wide-band, focused multibeam sonar ever to be deployed. Utilizing 240 dynamically focused receive beams, the system measures a 120° swath across the seafloor, detects the bottom, and delivers the measured ranges at a depth resolution of 6mm. The backscatter intensity image is displayed in real time on the sonar display.

The 8125 can be controlled through its native graphical user interface, or through an external control data collection and navigation software package.

The system can be mounted on a survey vessel or deployed on an ROV at depths down to 1500m. The high-speed data uplink is carried on a standard SeaBat copper cable for surface installation. A fiber-optical interface is available for ROV deployment.

- Focused 0.5° beams
- 240 beams
- 2.5cm near field resolution
- 6mm depth resolution
- 120° swath
SeaBat 8125
ULTRA HIGH RESOLUTION FOCUSED MULTIBEAM ECHOSOUNDER SYSTEM

SYSTEM PERFORMANCE

Frequency: 455kHz
Depth Resolution: 6mm
Swath Coverage: 120°
Max Range: 120m
Number of Beams: 240
Along-Track Beamwidth: 1°
Across-Track Beamwidth: 0.5° (at nadir)
Accuracy:
• IHO Special Order
• U.S. Army Corps of Engineers Special Order
Operational Speed: Up to 12 knots
Max. Update Rate: 40
Transducer Depth Rating: 600m (Standard)
1500m (Optional)

INTERFACE

System Supply: 115V/230V 50/60Hz, 350W max
Video Display: SVGA, 800 x 600, 72Hz
System Control: Trackball
Data Output: 10MB Ethernet or serial RS232C
Data Uplink: High-speed digital coax with fiber-optic option
Sonar Head Supply: 24VDC, 5.6A Peak, 2A Average
(May be supplied from sonar processor)
Temperature:
Operating: 0° to +40°C
Storage: -30° to +55°C

MECHANICAL INTERFACE

Power Requirements: 24VDC, 5.6A Peak, 2A Average
(May be supplied from sonar processor)
Operating Depth: 600m/1500m
Dimensions: 266 x 320mm (W / D) excluding projector
Temperature:
Operating: -5° to +40°C
Storage: -30° to +55°C
Weight (aluminum):
Dry: 26.8kg (59lbs.)
Wet: 4.8kg (10.6lbs.)
Weight (titanium):
Dry: 40kg (88lbs.)
Wet: 18kg (39.6lbs.)
Multi-beam Sonar System 5500 Specifications

### Towfish

<table>
<thead>
<tr>
<th>Specification</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of beams:</td>
<td>10 (5 per side)</td>
</tr>
<tr>
<td>Frequency:</td>
<td>455 kHz</td>
</tr>
<tr>
<td>Pulse length:</td>
<td>50 to 200usec user selectable</td>
</tr>
<tr>
<td>Resolution (along track):</td>
<td>20 cm to 75 m, increasing to 36 cm at 150 m max. range</td>
</tr>
<tr>
<td>Resolution (across track):</td>
<td>Determined by selected pulse length</td>
</tr>
<tr>
<td>Operating Speed Envelope:</td>
<td>2 to 10 knots @150 m Sonar Range</td>
</tr>
<tr>
<td>Sonar Digitization:</td>
<td>12 bits per channel</td>
</tr>
<tr>
<td>Maximum Operating Range:</td>
<td>150 m (300 m Swath)</td>
</tr>
<tr>
<td>Array Length:</td>
<td>120 cm (47.2 in)</td>
</tr>
<tr>
<td>Body length:</td>
<td>194 centimeters (76.4 in)</td>
</tr>
<tr>
<td>Body Diameter:</td>
<td>15.2 centimeters (6 in.)</td>
</tr>
<tr>
<td>Weight in air:</td>
<td>70 kg (155 lbs.) nominal</td>
</tr>
<tr>
<td>Heading sensor:</td>
<td>Standard Equipment</td>
</tr>
<tr>
<td>Pressure sensor:</td>
<td>Standard Equipment</td>
</tr>
<tr>
<td>Pitch and roll sensor:</td>
<td>Standard Equipment</td>
</tr>
<tr>
<td>Altimeter sensor:</td>
<td>Standard Equipment</td>
</tr>
</tbody>
</table>

### Towfish Options

<table>
<thead>
<tr>
<th>Specification</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Yaw Rate &amp; High Resolution Roll Sensors:</td>
<td>Optional</td>
</tr>
<tr>
<td>Temperature Sensor:</td>
<td>Optional</td>
</tr>
<tr>
<td>Responder:</td>
<td>Optional</td>
</tr>
</tbody>
</table>

### Tranceiver Processor Unit

<table>
<thead>
<tr>
<th>Specification</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Width:</td>
<td>19 in. rack mount</td>
</tr>
<tr>
<td>Height:</td>
<td>13.2 cm (5.2 in)</td>
</tr>
<tr>
<td>Depth:</td>
<td>54.6 cm (21.5 in)</td>
</tr>
<tr>
<td>Weight:</td>
<td>12.7 kg (28 lbs.)</td>
</tr>
<tr>
<td>Voltage:</td>
<td>115 / 240 VAC</td>
</tr>
<tr>
<td>Power:</td>
<td>120 watts</td>
</tr>
<tr>
<td>Navigation Input:</td>
<td>NEMA 0183</td>
</tr>
<tr>
<td>Data Output</td>
<td>100 Base-Tx Ethernet LAN</td>
</tr>
<tr>
<td>-------------------</td>
<td>--------------------------</td>
</tr>
<tr>
<td>PC Display / Control Unit</td>
<td>Klein Ruggedized or Customer Supplied PC</td>
</tr>
<tr>
<td>Display Software</td>
<td>SonarPro Software suite</td>
</tr>
</tbody>
</table>

**Towcable**

<table>
<thead>
<tr>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Coaxial or Fiber-optic double armored steel.</td>
</tr>
<tr>
<td>Contact Klein for specifications</td>
</tr>
</tbody>
</table>
C3D-LPM Transceiver
The C3D-LPM transceiver houses the DSP, power supply and all the circuitry necessary for signal processing. The transceiver module interfaces to a standard PC (either supplied by Teledyne Benthos or customer supplied) via Ethernet. The DSP runs on 110/220 VAC power auto sensing.

C3D-PC All-in-One Computer
The C3D-PC is an all-in-one computer installed with third party acquisition software to display and store C3D data. The small footprint allows for easy installation on most small vessels. The PC operates on 110/220 VAC auto sensing.
# C3D-LPM Sonar Imaging System

## System Specifications

### C3D System

<table>
<thead>
<tr>
<th>Specification</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sonar Frequency</td>
<td>200 kHz</td>
</tr>
<tr>
<td>Side Scan Range</td>
<td>25 to 300 meters per side</td>
</tr>
<tr>
<td>Bathymetric Range</td>
<td>10 to 12 times water depth</td>
</tr>
<tr>
<td>Resolution (across track)</td>
<td></td>
</tr>
<tr>
<td>Side Scan Sonar</td>
<td>4.5 cm</td>
</tr>
<tr>
<td>Bathymetry</td>
<td>5.5 cm</td>
</tr>
<tr>
<td>Beam Width</td>
<td>1 degree (one-way)</td>
</tr>
<tr>
<td>Pulse Length</td>
<td>25 usec to 1 msec (depending on range)</td>
</tr>
<tr>
<td>Repetition Rate</td>
<td>Up to 30 pings/sec</td>
</tr>
<tr>
<td>Depression Angle</td>
<td>20, 30, 40 degrees</td>
</tr>
<tr>
<td>Transmit Source Level</td>
<td>Max. 224dB re: 1uPa@1M</td>
</tr>
</tbody>
</table>

### C3D-LPM

<table>
<thead>
<tr>
<th>Specification</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Construction</td>
<td>Stainless steel imbedded in glass filled polyurethane</td>
</tr>
<tr>
<td>Length</td>
<td>99.3 cm (39.1 inches)</td>
</tr>
<tr>
<td>Diameter</td>
<td>17.3 cm (6.8 inches)</td>
</tr>
<tr>
<td>Weight (in air)</td>
<td>20.4 kg (45 lbs)</td>
</tr>
</tbody>
</table>

### C3D-LPM Transceiver

<table>
<thead>
<tr>
<th>Specification</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Topside Interface</td>
<td></td>
</tr>
<tr>
<td>Power Supply</td>
<td>Input 110/220 VAC auto sensing</td>
</tr>
<tr>
<td>Network interface</td>
<td>Ethernet</td>
</tr>
<tr>
<td>Dimensions</td>
<td>2U Rack mount 48.3 cm (19 inches)</td>
</tr>
<tr>
<td>Weight</td>
<td>9.5 kg (21 lbs)</td>
</tr>
<tr>
<td>Transducer Cables</td>
<td>10 meters standard</td>
</tr>
</tbody>
</table>

### C3D-PC

<table>
<thead>
<tr>
<th>Specification</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating System</td>
<td>Windows XP</td>
</tr>
<tr>
<td>Processor</td>
<td>Pentium processor</td>
</tr>
<tr>
<td>Storage</td>
<td>Large capacity hard drive, writable CD/DVD</td>
</tr>
<tr>
<td>Network Interface</td>
<td>100base T Ethernet (compatible with ADSL high-speed communications interface)</td>
</tr>
<tr>
<td>Serial</td>
<td>RS232</td>
</tr>
<tr>
<td>Display Monitor</td>
<td>17” flat panel (built into processor)</td>
</tr>
</tbody>
</table>

Specifications subject to change without notice. 3/2007. ©2007 TELEDYNE BENTHOS, Inc. Other products and company names mentioned herein may be trademarks and/or registered trademarks.
HYDROGRAPHIC ECHO SOUNDER

DUAL FREQUENCY WITH OPTIONAL THIRD CHANNEL

- Modular “black box” configuration includes rack mount option, Ethernet LAN interface, frequency agile configurable transceivers, standard serial interfaces for data acquisition systems, motion sensors and DGPS receivers.

- Options include modular sunlight viewable color LCD chart with internal data storage, high-resolution thermal paper recorder or display and control on your PC!
You asked for more convenience and superior efficiency in your hydrographic survey tools. Odom answered.

Say hello to Echotrac CV™! With this new echo sounder, Odom delivers the perfect union of flexibility and technology, viewed through a user-friendly networked Windows interface. Alongside the advanced features and options that made the Echotrac™ MKIII a stand-out product, the CV brings users to the next level by providing an optional third acoustic channel. Whether it's a side scan, bathymetric or a shallow subbottom investigation, the CV has the flexibility to handle the task!

*Buy Odom — invest in your peace of mind.*

---

**SPECIFICATIONS**

- **Frequency**
  - High band: 100 kHz – 1 MHz
  - Low band: 10 kHz – 50 kHz
  - Optional very low band: 3 kHz to 24 kHz

- **Output Power**
  - High: 100 kHz – 1 kW RMS max
  - 900 W RMS max, 750 kHz – 300 W RMS max
  - Low: 12 kHz – 2 kW RMS max, 50 kHz – 1.5 kHz RMS max
  - Very low: 3 kHz to 6000 W RMS max (transducer impedance dependent)

- **Input Power**
  - 110 or 220 V AC – 24 V DC 50 watts

- **Resolution**
  - 0.01 m/0.1 ft

- **Accuracy**
  - 0.01 m/0.10 ft +/- 0.1% of depth @ 200 kHz
  - 0.10 m/0.30 ft +/- 0.1% of depth @ 33 kHz
  - 0.18 m/0.60 ft +/- 0.1% of depth @ 12 kHz

- **Depth Range**
  - 0.2 – 200 m/0.6 – 600 ft @ 200 kHz
  - 0.5 – 1600 m/1.5 – 5000 ft @ 33 kHz
  - 1.0 – 6000 m/3.0 – 20,000 ft @ 12 kHz

- **Phasing**
  - Automatic scale change, 10%, 20%, 30% overlap or manual

- **Printer**
  - High resolution 8 dot/mm (203 dpi), 16 gray shades, 216 mm (8.5 in) wide thermal paper or film
  - External ON/OFF switch
  - Paper advance control

- **Paper Speed**
  - 1 cm/min (0.5 in/min) to 22 cm/mm (8.5 in/min), automatic

- **LCD Display**
  - 15 in TFT screen
  - High-Bright (500 NIT)
  - Internal data storage in XTF format on 40 GB hard disk
  - Data transfer via Ethernet interface or USB flash drive

- **Sound Velocity**
  - 1370 – 1700 m/s
  - Resolution 1 m/s

- **Transducer Draft Setting**
  - 0 – 15 m (0 – 50 ft)

- **Depth Display**
  - On control PC and remote LCD display

- **Clock**
  - Internal battery backed time, elapsed time and date clock

- **Annotation**
  - Internal – date, time, GPS position
  - External – from RS232 or ethernet

- **Interfaces**
  - 4 x RS232 or 3 x RS232 and 1 x RS422
  - Inputs from external computer, motion sensor, sound velocity
  - Outputs to external computer, remote display
  - Outputs with LCD chart – VGA video out
  - Ethernet interface

- **Blanking**
  - 0 to full scale

- **Installation**
  - Desktop or optional rack mount
  - bulkhead mount

- **Software**
  - Echotrac control supplied
  - ChartView supplied with LCD configuration

---

**Help**

- The function of each parameter and its minimum and maximum values can be printed on the paper chart. Also, a record of all parameter settings can be printed on the chart.

**Environmental Operating Temperature**

- 0°–50° C, 5% – 90% relative humidity, non-condensing

**Dimensions**

- 9 mm (0.3 in) H x 45 mm (1.7 in) W x 300 mm (12.8 in) D

**Weight**

- 15.9 kg (35 lbs)

**Options**

- Third acoustic channel (multiple configurations)
- Remote display
- Side scan transducer – single or dual channel side looking 200 kHz or 340 kHz for search and reconnaissance
- Built-in DGPS
- Subbottom Array (0.5 kHz 4 element array with stainless steel mounting frame typically)

---

**1450 Seaboard Avenue**

**Baton Rouge, Louisiana 70810-6261 USA**

**E-mail: email@odomhydrographic.com**

**wwwodomhydrographic.com**
SEACAT Profiler

The SBE 19plus is the next generation Personal CTD, bringing numerous improvements in accuracy, resolution (in fresh as well as salt water), reliability, and ease-of-use to the wide range of research, monitoring, and engineering applications pioneered by its legendary SEACAT predecessor. The 19plus samples faster (4 Hz vs 2), is more accurate (0.005 vs 0.01 in T, 0.0005 vs 0.001 in C, and 0.1% vs 0.25% — with seven times the resolution — in D), and has more memory (3 Mbyte vs 1). There is more power for auxiliary sensors (500 mV vs 60), and they are acquired at higher resolution (14-bit vs 12). Cabling is simpler and more reliable because there are four differential auxiliary inputs on two separate connectors, and a dedicated connector for the pump. All exposed metal parts are titanium, instead of aluminum, for long life and minimum maintenance.

The 19plus can be operated without a computer from even the smallest boat, with data recorded in non-volatile FLASH memory and processed later on your PC. Simultaneous with recording, real-time data can be transmitted over single-core, armored cable directly to your PC's serial port (maximum transmission distance dependent on number of auxiliary sensors, baud rate, and cable properties). The 19plus' faster sampling and pump-controlled TC-dusted flow configuration significantly reduces salinity spiking caused by ship heave, and allows slower descent rates for improved resolution of water column features. Auxiliary sensors for dissolved oxygen, pH, turbidity, fluorescence, and PAR can be added. For moored deployments, the 19plus can be set to time-series mode using software commands. External power and two-way real-time communication over 10,000 meters of cable can be provided with the SBE 36 CTD Deck Unit and Power and Data Interface Module (PDIM).

The 19plus uses the same temperature and conductivity sensors proven in 5000 SEACAT and MicroCAT instruments, and a superior new micro-machined silicon strain gauge pressure sensor developed by Druck, Inc. Improvements in design, materials, and signal acquisition techniques yield a low-cost instrument with superior performance that is also easy to use. Calibration coefficients, obtained in our computer-controlled high-accuracy calibration baths, are stored in EEPROM memory. They permit data output in ASCII engineering units (degrees C, Siemens/m, decaB, Salinity [PSU], sound velocity [m/sec], etc.).

Accuracy, convenience, portability, software, and support: compelling reasons why the 19plus is today's best low-cost CTD.

CONFIGURATION AND OPTIONS

A standard SBE 19plus is supplied with:
- Plastic housing for depths to 600 meters
- Strain-gauge pressure sensor
- 8 Mbyte FLASH RAM memory
- 9 D-size alkaline batteries
- Impulse glass-reinforced epoxy bulkhead connectors, 4-pin I/O, 2-pin pump, and two 6-pin (two differential auxiliary A/D inputs each)
- SBE 5M miniature pump with plastic housing for depths to 600 meters, and T-C Duct.

Options include:
- Titanium housing for depths to 7000 meters
- SBE 5M miniature pump with titanium housing in place of plastic housing
- SBE 5P (plastic) or 5T (titanium) pump in place of SBE 5M for use with dissolved oxygen and/or other pumped sensors
- Bulkhead connector for use with PAR sensor
- Sensors for oxygen, pH (for integration in Profiling mode only), fluorescence, light (PAR), light transmission, and turbidity
- Stainless steel cage
- MCBi-Micro connectors in place of glass-reinforced epoxy connectors
- Nickel Metal Hydride (NiMH) or Nickel-Cadmium (Ni-Cad) batteries and charger
- Moored mode conversion kit with anti-foulant device fittings

SOFTWARE

The SBE 19plus is supplied with a powerful Windows 2000/XP software package, SEASOFT®, which includes:
- SEATERM® — communication and data retrieval
- SEASAVE® — real-time data acquisition and display
- SBE Data Processing® — filtering, aligning, averaging, and plotting of CTD and auxiliary sensor data and derived variables

Sea-Bird Electronics, Inc.
1808 136th Place NE, Bellevue, Washington 98005 USA
Website: http://www.seabird.com

E-mail: seabird@seabird.com
Telephone: (425) 843-0886
Fax: (425) 843-0994
SEACAT Profiler

SPECIFICATIONS

<table>
<thead>
<tr>
<th>Measurement Range</th>
<th>Initial Accuracy</th>
<th>Typical Stability (per month)</th>
<th>Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Conductivity (S/m)</td>
<td>0 to 9</td>
<td>0.0005</td>
<td>0.00005</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>(most oceanic waters, resolves 0.4 ppm in salinity)</td>
</tr>
<tr>
<td>Temperature (°C)</td>
<td>-5 to +35</td>
<td>0.0006</td>
<td>0.00007</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>(high salinity waters, resolves 0.4 ppm in salinity)</td>
</tr>
<tr>
<td>Pressure</td>
<td>0 to 20/100/350/600/1000/2000/3500/7000 meters</td>
<td>0.1% of full scale range</td>
<td>0.00001</td>
</tr>
<tr>
<td></td>
<td></td>
<td>0.0004% of full scale range</td>
<td>(fresh waters, resolves 0.1 ppm in salinity)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>0.001</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>(0.02% of full scale range)</td>
</tr>
</tbody>
</table>

Memory: 8 Mbyte non-volatile FLASH memory

Data Storage
- Recorded Parameter: T + C, pressure, each external voltage
- Bytes/Sample: 6, 5, 2

Real-Time Clock: 32,768 Hz TCXO accurate to ±1 minute/year

Internal Batteries: 9 alkaline D-cells (Duracell MN1300, LR20) provide 80 hours profiling; optional 9-cell NiMH battery pack provides 40 hours profiling per charge; optional 9-cell Ni-Cad battery pack provides 24 hours profiling per charge

External Power Supply: 9 - 26 VDC; consult factory for required current

Power Requirements:
- Sampling: 85 mA
- Pump: SBE 5M: 100 mA
- Communications: 80 mA
- Quiescent: 30 μA
- Auxiliary power out: up to 500 mA at 10.5 - 11 VDC
- A/D resolution: 14 bits
- Input range: 0 - 5 VDC

Housing Materials: Depth Rating, Weight in air*, Weight in water*
- Acetal Copolymer Plastic housing, 600 meter (1950 feet), 7.3 kg (16 lbs), 2.3 kg (5 lbs)
- 3A1-2.5V Titanium housing, 7000 meter (22,900 feet), 13.7 kg (30 lbs), 6.6 kg (14 lbs)
- *Weights listed are without pump; pump adds (in air) 0.3 to 0.7 kg (0.6 to 1.5 lbs), depending on pump model selected; see pump brochures for details.

Optional Cage:
- 1018 mm x 241 mm x 279 mm (40 in. x 9.5 in. x 11 in.), 6.3 kg (14 lbs)

Sea-Bird Electronics, Inc.
1808 136th Place NE, Bellevue, Washington 98005 USA
Website: http://www.seabird.com
E-mail: seabird@seabird.com
Telephone: (425) 643-9668
Fax: (425) 643-9054
The Digibar Pro™ is the most cost-efficient and accurate means of determining water column sound velocities. It quickly calibrates acoustic systems regardless of sea state or current, and is faster and safer than the traditional bar check method. Digibar Pro™ uses “sing-around” technology, which automatically compensates for all factors influencing sound velocity, including salinity, depth and temperature.

*Buy Odom – invest in your peace of mind.*

**DIGIBAR PRO™**
**FOR SEAFLOOR OR RIVERBED SURVEYS**

### GENERAL SPECIFICATIONS

**PROBE**
- Sing-Around Frequency
  - 11 kHz
- Communications
  - RS485, 19.2 kbaud
- Temperature Range
  - 39° F - 104° (4° C – 40° C) Typical
- Sample Rate
  - 10 Hz
- Depth Sensor Accuracy
  - 1.0 ft (31.0 cm)
- Dimensions
  - 14.7 l x 2.0 d in (37.3 l x 5.0 d cm)
- Topside Unit
  - Velocity range
    - 4595 – 5250 ft/sec (1400 – 1600 m/sec)
  - Resolution
    - 0.1 ft/sec (0.1 m/sec)
  - Accuracy
    - +/- 1 ft/sec (+/- 0.3 m/sec)
  - Power Requirement
    - Three “C” cell batteries
  - Communications
    - RS232, selectable baud rate
- Dimensions
  - 11.4 l x 5.5 w x 3.7 d inches (29.0 l x 14.0 w x 9.4 d cm)
- Weight
  - 2.6 lbs (1.2 kg)

### FEATURES

- Velocity profiles downloaded to a computer
- Handheld display//logger with computer interface
- Battery operated
- RS232/RS485
- Detachable cable (in lengths up to 100 meters)
- Sampling by depth or time
- Stainless steel probe
- Waterproof
- Lightweight
- Portable
- Optional transit cases

### CABLE

- 4-conductor, Polyethylene-jacketed with Kevlar strength member
- Breaking Strength
  - 400 lbs (182 kg)
- 4-conductor, Polyethelene-jacketed with Kevlar strength member
- Breaking Strength
  - 400 lbs (182 kg)

---

**O DOM HYDROGRAPHIC SYSTEMS**
1450 Seaboard Avenue
Baton Rouge, Louisiana 70810-6261 USA
E-mail: email@odomhydrographic.com
www.odomhydrographic.com

ODOM HYDROGRAPHIC SYSTEMS, INC. (225) 769-3051 - (225) 766-5122 FAX
### DMS 132 Receiver

Table E.1 lists the characteristics of the DSM 132.

<table>
<thead>
<tr>
<th>Characteristic</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Size</strong></td>
<td>14.5 cm W x 5.1 cm H x 19.5 cm D (5.7 in W x 2.0 in H x 7.7 in D)</td>
</tr>
<tr>
<td><strong>Weight</strong></td>
<td>0.76 kg (1.66 lb)</td>
</tr>
<tr>
<td><strong>Power</strong></td>
<td>7 Watts (max), 10–32 VDC</td>
</tr>
<tr>
<td><strong>Operating temperature</strong></td>
<td>−20 °C to +85 °C (−4 °F to +149 °F)</td>
</tr>
<tr>
<td><strong>Storage temperature</strong></td>
<td>−30 °C to +85 °C (−22 °F to +185 °F)</td>
</tr>
<tr>
<td><strong>Humidity</strong></td>
<td>100% condensing, unit fully sealed</td>
</tr>
<tr>
<td><strong>Casing</strong></td>
<td>Dust-proof, waterproof, shock resistant</td>
</tr>
</tbody>
</table>

### Combined Antenna

Table E.2 lists the physical characteristics of the combined antenna.

<table>
<thead>
<tr>
<th>Characteristic</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Size</strong></td>
<td>15.5 cm D x 14.0 cm H (6.1 in D x 5.5 in H)</td>
</tr>
<tr>
<td><strong>Weight</strong></td>
<td>0.55 Kg (1.2 lb)</td>
</tr>
<tr>
<td><strong>Operating temperature</strong></td>
<td>−30 °C to +85 °C (−22 °F to +149 °F)</td>
</tr>
<tr>
<td><strong>Storage temperature</strong></td>
<td>−40°C to +60°C (−40°F to +140°F)</td>
</tr>
<tr>
<td><strong>Humidity</strong></td>
<td>100% condensing, unit fully sealed</td>
</tr>
<tr>
<td><strong>Casing</strong></td>
<td>Dust-proof, waterproof, shock resistant</td>
</tr>
</tbody>
</table>
GPS Channels

Table E.3 lists the performance characteristics of GPS channels.

<table>
<thead>
<tr>
<th>Table E.3</th>
<th>GPS channels performance characteristics</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>General</strong></td>
<td>12-channel, parallel tracking L1 L1b 1571.42 MHz C/A code and carrier phase filtered measurements and multi-bit digitizer</td>
</tr>
<tr>
<td><strong>Update rate</strong></td>
<td>Selectable 1, 2, 5, or 10 Hz output rate</td>
</tr>
<tr>
<td><strong>Differential speed accuracy</strong></td>
<td>0.16 kph (0.1 mph)</td>
</tr>
<tr>
<td><strong>Differential position accuracy</strong></td>
<td>Less than 1 m horizontal RMS if all the following criteria are met: At least 5 satellites, PDOP &lt; 4, RTCM SC-104 Standard format broadcast from a Trimble DSM 132RS or equivalent reference station</td>
</tr>
<tr>
<td><strong>Time to first fix</strong></td>
<td>&lt; 30 seconds, typical</td>
</tr>
<tr>
<td><strong>NMEA messages</strong></td>
<td>GGA, GLL, GSR, GSA, GSV, GMS, PTNLDG, PTNL, PTNLEV, PTNLID, PTNLSM, RMC, VTG, XTE, ZDA</td>
</tr>
</tbody>
</table>

1By default, the receiver is configured to output GGA, GSA, RMC, and VTG messages at an 1 Hz (1 position/second) update rate.

Beacon Channels

Table E.4 lists the characteristics of the beacon channels.

<table>
<thead>
<tr>
<th>Table E.4</th>
<th>Beacon Channels</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Frequency range</strong></td>
<td>283.5 kHz to 328.0 kHz</td>
</tr>
<tr>
<td><strong>Channel Spacing</strong></td>
<td>500 Hz</td>
</tr>
<tr>
<td><strong>Beacon modulation</strong></td>
<td>50, 100, and 200 bits/second</td>
</tr>
<tr>
<td><strong>Signal strength</strong></td>
<td>10 μV/meter minimum</td>
</tr>
<tr>
<td><strong>Dynamic range</strong></td>
<td>100 dB</td>
</tr>
<tr>
<td><strong>Channel selectivity</strong></td>
<td>70 dB @ &gt; 500 Hz offset</td>
</tr>
</tbody>
</table>
Table E.4  Beacon Channels (continued)

<table>
<thead>
<tr>
<th>Specification</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Frequency offset</td>
<td>17 ppm maximum</td>
</tr>
<tr>
<td>3rd order intercept</td>
<td>+15 dBm @ RF input (min. AGC setting)</td>
</tr>
<tr>
<td>Beacon acquisition time</td>
<td>&lt;5 seconds, typical</td>
</tr>
<tr>
<td>Operating modes</td>
<td>Auto Power, Auto Range, and Manual</td>
</tr>
</tbody>
</table>

L-Band Satellite Differential Correction Receiver
Table E.5 lists the characteristics of the L-band satellite differential correction receiver with multiple vendor support.

Table E.5  L-Band satellite differential correction receiver with multiple vendor support characteristics

<table>
<thead>
<tr>
<th>Specification</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bit error rate</td>
<td>$10^{-6}$ for Ebn/N of &gt;5.5 dB</td>
</tr>
<tr>
<td>Acquisition and reacquisition time</td>
<td>&lt;5 seconds, typical</td>
</tr>
<tr>
<td>Frequency band</td>
<td>1525–1560 MHz</td>
</tr>
<tr>
<td>Channel spacing</td>
<td>5 kHz</td>
</tr>
</tbody>
</table>

Receiver Default Settings
Table E.6 lists the receiver default settings.

Table E.6  Receiver default settings

<table>
<thead>
<tr>
<th>Specification</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>DGPS Source</td>
<td>WAAS/EGNOS</td>
</tr>
<tr>
<td>Dynamics</td>
<td>Land</td>
</tr>
<tr>
<td>Minimum elevation</td>
<td>8°</td>
</tr>
<tr>
<td>AMU mask</td>
<td>3</td>
</tr>
<tr>
<td>PDOP Mask</td>
<td>13°</td>
</tr>
<tr>
<td>PDOP 2D/3D switch</td>
<td>11</td>
</tr>
<tr>
<td>PY Filter</td>
<td>D&amp;S (Dynamic and Static mode)</td>
</tr>
<tr>
<td><strong>Table E.6</strong></td>
<td><strong>Receiver default settings (continued)</strong></td>
</tr>
<tr>
<td>---------------</td>
<td>------------------------------------------</td>
</tr>
<tr>
<td>C.C. Filter</td>
<td>Enhanced</td>
</tr>
<tr>
<td>DGPS mode</td>
<td>Auto On/Off</td>
</tr>
<tr>
<td>DGPS correction age limit</td>
<td>30 seconds</td>
</tr>
<tr>
<td>Pos fix rate</td>
<td>1 Hz</td>
</tr>
</tbody>
</table>
APPENDIX II
Bathymetry Data Cleaning to PSS

Daily “Raw” Data Sources from Boat
- SEACAT sound speed profile casts
- SWMB XTF data + Survey.log
- POS-MV True Heave
- VBES & DP HYPACK data

Project Related Data Submission
- VelocWin
- NODC Files
- Project Related Data Submission
- Tides data
- Sensor offsets, draught, biases

Tides data
- Tide, SVP, VCF
- Clean depths
- Clean HRP

Load tides & SVP data
- HDCS P/V/D/Ls
- Load tides & SVP data
- Clean HRP
- SVP correct

SVP files
- TID files
- HVF files

CARIS Tools
- Surface Creation
- Field Sheet Editor

Other Tools: VESA, Geozui, …?

Other Tools: VESA, Geozui, …?

Pydro
- Zoned Tides
- CARIS Tools
  - Surface Creation
  - Field Sheet Editor

Merge & Compute TPE

Merge & Compute TPE

Sensor offsets, draught, biases

VCF files
- SVP correct
- Clean ObsDepths

Sensor offsets, draught, biases
Data Flow Diagram -- Data Integration with Pydro

Isis

Hypack

Data Conversion

Caris HIPS/SIPS

HIPS Depths
Bathymetry & Features

SIPS Side Scan Contacts
Features

PSS Compilation

Pydro

PSS Bathymetry Features

HydroMI* (MapInfo)

GIS & Plots

Pydro Coverage Tool

Bathymetry & Side Scan Rasters

Raster Coverage from Observed/Processed Depths
SSS<Processed>SideScan

Observed/Processed Depths SideScan
SIPS Side Scan Data

A single launch days worth of data

Launch XTF & Survey.log

Convert XTF

RAID

SSMOS Data

Examine/clean gyro

Examine/clean navigation

Examine/clean fish height

Re-compute SSS Nav

Mosaics

Mosaic subsets at 1.0 meter resolution

Slant range correct with beam pattern

Contacts

Draw features in MapInfo

Insert “CarisLine Features” Into PYDRO

Save PSS

Update contacts file/write .tiff files

Pick contacts 40 X 40
Vessel Name: NRT7_S3004_C3D_100.hvf
Vessel created: The vessel file was not saved at the time this report was generated.

Depth Sensor:

Sensor Class:    Swath
Time Stamp:      2006-121 00:00

Transducer #1:
-------------
Pitch Offset:   0.000
Roll Offset:    0.000
Azimuth Offset: 0.000

DeltaX: 1.376
DeltaY: -2.050
DeltaZ: 0.811

Manufacturer:    Benthos
Model:           Unknown
Serial Number:

Depth Sensor:

Sensor Class:    Swath
Time Stamp:      2007-079 00:00

Transducer #1:
-------------
Pitch Offset:   -0.300
Roll Offset:    -0.300
Azimuth Offset: -1.900

DeltaX: 1.284
DeltaY: -1.996
DeltaZ: 0.612

Manufacturer:    Benthos
Model:           benthosC3d
Serial Number:
Navigation Sensor:

Time Stamp: 2005-299 00:00

Comments Offset applied in POS
Latency 0.000
DeltaX: 0.000
DeltaY: 0.000
DeltaZ: 0.000

Manufacturer: Applanix
Model: POSMV v4
Serial Number: (null)

Gyro Sensor:

Time Stamp: 2005-299 00:00

Comments (null)
Latency 0.000

Heave Sensor:

Time Stamp: 2005-299 00:00

Comments RP to IMU
Apply Yes
Latency 0.000
DeltaX: 0.000
DeltaY: 0.000
DeltaZ: 0.000
Offset: 0.000

Manufacturer: (null)
Model: (null)
Serial Number: (null)

Pitch Sensor:
Time Stamp: 2005-299 00:00

Comments (null)
Apply Yes
Latency 0.000
Pitch offset: 0.000

Manufacturer: (null)
Model: (null)
Serial Number: (null)

Roll Sensor:

Time Stamp: 2005-299 00:00

Comments (null)
Apply Yes
Latency 0.000
Roll offset: 0.000

Manufacturer: (null)
Model: (null)
Serial Number: (null)

Draft Sensor:

Time Stamp: 2005-299 00:00

Apply Yes
Comments From S3002
Entry 1) Draft: 0.000  Speed: 0.000
Entry 2) Draft: 0.101  Speed: 2.000
Entry 3) Draft: 0.108  Speed: 3.500
Entry 4) Draft: 0.202  Speed: 4.500
Entry 5) Draft: 0.204  Speed: 6.000
Entry 6) Draft: 0.076  Speed: 7.500

Time Stamp: 2005-305 00:00

Apply Yes
Comments Steve's Calc
Entry 1) Draft: 0.000  Speed: 1.800
Entry 2) Draft: -0.020  Speed: 4.200
Entry 3) Draft: -0.020  Speed: 5.000
Entry 4) Draft: -0.060  Speed: 6.400
Entry 5) Draft: -0.020  Speed: 7.300
Entry 6) Draft: 0.000  Speed: 8.200

TPE

Time Stamp: 2007-079 00:00

Comments Offsets corrected in POS, SDs from HSTD2007_2

Offsets

Motion sensing unit to the transducer 1
  X Head 1 0.000
  Y Head 1 0.000
  Z Head 1 0.000

Motion sensing unit to the transducer 2
  X Head 2 0.000
  Y Head 2 0.000
  Z Head 2 0.000

Navigation antenna to the transducer 1
  X Head 1 0.000
  Y Head 1 0.000
  Z Head 1 0.000

Navigation antenna to the transducer 2
  X Head 2 0.000
  Y Head 2 0.000
  Z Head 2 0.000

Roll offset of transducer number 1 0.000
Roll offset of transducer number 2 0.000

Heave Error: 0.050 or 5.000" of heave amplitude.
Measurement errors: 0.050

Motion sensing unit alignment errors
Gyro:1.000  Pitch:1.000  Roll:1.000
Gyro measurement error: 0.020
Roll measurement error: 0.020
Pitch measurement error: 0.020
Navigation measurement error: 1.000
Transducer timing error: 0.010
Navigation timing error: 0.010
Gyro timing error: 0.010
Heave timing error: 0.010
PitchTimingStdDev: 0.010
Roll timing error: 0.010
Sound Velocity speed measurement error: 0.000
Surface sound speed measurement error: 0.000
Tide measurement error: 0.000
Tide zoning error: 0.000
Speed over ground measurement error: 0.030
Dynamic loading measurement error: 0.150
Static draft measurement error: 0.100
Delta draft measurement error: 0.020
StDev Comment: `éƒJ Ï…Jö…JPô…J°ð…J Ï…J…J@í…J°kJàZJÖ…Ja

Svp Sensor:

Time Stamp: 2006-121 00:00

Comments
Svp #1:
-------------
Pitch Offset: 0.000
Roll Offset: 0.000
Azimuth Offset: 0.000

DeltaX: 1.376
DeltaY: -2.050
DeltaZ: 0.811

SVP #2:
-------------
Pitch Offset: 0.000
Roll Offset: 0.000
Azimuth Offset: 0.000

DeltaX: 0.000
DeltaY: 0.000
DeltaZ: 0.000

Time Stamp: 2007-079 00:00
Comments (null)
Svp #1:
-------------
Pitch Offset:  0.000
Roll Offset:  0.000
Azimuth Offset: 0.000

DeltaX: 1.284
DeltaY: -1.996
DeltaZ: 0.612

SVP #2:
-------------
Pitch Offset:  0.000
Roll Offset:  0.000
Azimuth Offset: 0.000

DeltaX: 0.000
DeltaY: 0.000
DeltaZ: 0.000

WaterLine:

Time Stamp:      2005-300 00:00

Comments RP to WL
Apply Yes
WaterLine -0.080
Vessel Name: NRT7_S3004_C3D_200.hvf
Vessel created: The vessel file was not saved at the time this report was generated.

Depth Sensor:

Sensor Class:    Swath
Time Stamp:      2006-121 00:00

Transducer #1:
-------------
Pitch Offset:   0.000
Roll Offset:    0.000
Azimuth Offset: 0.000

DeltaX: 1.376
DeltaY: -2.050
DeltaZ: 0.811

Manufacturer:    Benthos
Model:           Unknown
Serial Number:

Depth Sensor:

Sensor Class:    Swath
Time Stamp:      2007-079 00:00

Transducer #1:
-------------
Pitch Offset:   -0.300
Roll Offset:    -0.300
Azimuth Offset: -1.900

DeltaX: 1.284
DeltaY: -1.996
DeltaZ: 0.612

Manufacturer:    Benthos
Model:           benthosC3d
Serial Number:
Navigation Sensor:

Time Stamp: 2005-299 00:00

Comments Offset applied in POS
Latency 0.000
DeltaX: 0.000
DeltaY: 0.000
DeltaZ: 0.000

Manufacturer: Applanix
Model: POSMV v4
Serial Number: (null)

Gyro Sensor:

Time Stamp: 2005-299 00:00

Comments (null)
Latency 0.000

Heave Sensor:

Time Stamp: 2005-299 00:00

Comments RP to IMU
Apply Yes
Latency 0.000
DeltaX: 0.000
DeltaY: 0.000
DeltaZ: 0.000
Offset: 0.000

Manufacturer: (null)
Model: (null)
Serial Number: (null)

Pitch Sensor:
Time Stamp: 2005-299 00:00

Comments (null)
Apply Yes
Latency 0.000
Pitch offset: 0.000

Manufacturer: (null)
Model: (null)
Serial Number: (null)

Roll Sensor:

Time Stamp: 2005-299 00:00

Comments (null)
Apply Yes
Latency 0.000
Roll offset: 0.000

Manufacturer: (null)
Model: (null)
Serial Number: (null)

Draft Sensor:

Time Stamp: 2005-299 00:00

Apply Yes
Comments From S3002
Entry 1) Draft: 0.000  Speed: 0.000
Entry 2) Draft: 0.101  Speed: 2.000
Entry 3) Draft: 0.108  Speed: 3.500
Entry 4) Draft: 0.202  Speed: 4.500
Entry 5) Draft: 0.204  Speed: 6.000
Entry 6) Draft: 0.076  Speed: 7.500

Time Stamp: 2005-305 00:00

Apply Yes
Comments Steve's Calc
Entry 1) Draft: 0.000   Speed: 1.800
Entry 2) Draft: -0.020  Speed: 4.200
Entry 3) Draft: -0.020  Speed: 5.000
Entry 4) Draft: -0.060  Speed: 6.400
Entry 5) Draft: -0.020  Speed: 7.300
Entry 6) Draft: 0.000   Speed: 8.200

TPE

Time Stamp: 2007-079 00:00

Comments Offsets corrected in POS, SDs from HSTD2007_2

Offsets

Motion sensing unit to the transducer 1
  X Head 1 0.000
  Y Head 1 0.000
  Z Head 1 0.000

Motion sensing unit to the transducer 2
  X Head 2 0.000
  Y Head 2 0.000
  Z Head 2 0.000

Navigation antenna to the transducer 1
  X Head 1 0.000
  Y Head 1 0.000
  Z Head 1 0.000

Navigation antenna to the transducer 2
  X Head 2 0.000
  Y Head 2 0.000
  Z Head 2 0.000

Roll offset of transducer number 1 0.000
Roll offset of transducer number 2 0.000

Heave Error: 0.050 or 5.000" of heave amplitude.
Measurement errors: 0.050
Motion sensing unit alignment errors
Gyro:1.000  Pitch:1.000  Roll:1.000
Gyro measurement error: 0.020
Roll measurement error: 0.020
Pitch measurement error: 0.020
Navigation measurement error: 1.000
Transducer timing error: 0.010
Navigation timing error: 0.010
Gyro timing error: 0.010
Heave timing error: 0.010
PitchTimingStdDev: 0.010
Roll timing error: 0.010
Sound Velocity speed measurement error: 0.000
Surface sound speed measurement error: 0.000
Tide measurement error: 0.000
Tide zoning error: 0.000
Speed over ground measurement error: 0.030
Dynamic loading measurement error: 0.150
Static draft measurement error: 0.100
Delta draft measurement error: 0.020
StDev Comment: `éƒJ Ï…Jö…JPö…Jö…J Ï…J...Jö...JkZJÓ…Ja

Svp Sensor:

Time Stamp: 2006-121 00:00

Comments
Svp #1:
----------
Pitch Offset:  0.000
Roll Offset:   0.000
Azimuth Offset: 0.000

DeltaX: 1.376
DeltaY: -2.050
DeltaZ:  0.811

SVP #2:
----------
Pitch Offset:  0.000
Roll Offset:   0.000
Azimuth Offset: 0.000

DeltaX: 0.000
DeltaY: 0.000
DeltaZ:  0.000

Time Stamp: 2007-079 00:00
Comments (null)
Svp #1:
----------
Pitch Offset: 0.000
Roll Offset: 0.000
Azimuth Offset: 0.000

DeltaX: 1.284
DeltaY: -1.996
DeltaZ: 0.612

SVP #2:
----------
Pitch Offset: 0.000
Roll Offset: 0.000
Azimuth Offset: 0.000

DeltaX: 0.000
DeltaY: 0.000
DeltaZ: 0.000

WaterLine:

Time Stamp: 2005-300 00:00

Comments RP to WL
Apply Yes
WaterLine -0.080

_________________________________________________________
Vessel Name: NRT7_S3004_C3D.hvf
Vessel created: The vessel file was not saved at the time this report was generated.

Depth Sensor:

Sensor Class:    Swath
Time Stamp:      2006-121 00:00

Transduer #1:
---------------
Pitch Offset:   0.000
Roll Offset:    0.000
Azimuth Offset: 0.000

DeltaX: 1.376
DeltaY: -2.050
DeltaZ: 0.811

Manufacturer:    Benthos
Model:           Unknown
Serial Number:

Depth Sensor:

Sensor Class:    Swath
Time Stamp:      2007-079 00:00

Transduer #1:
---------------
Pitch Offset:   -0.300
Roll Offset:    -0.300
Azimuth Offset: -1.900

DeltaX: 1.284
DeltaY: -1.996
DeltaZ: 0.612

Manufacturer:    Benthos
Model:           benthosC3d
Serial Number:
Navigation Sensor:

Time Stamp: 2005-299 00:00

Comments Offset applied in POS
Latency 0.000
DeltaX: 0.000
DeltaY: 0.000
DeltaZ: 0.000

Manufacturer: Applanix
Model: POSMV v4
Serial Number: (null)

Gyro Sensor:

Time Stamp: 2005-299 00:00

Comments (null)
Latency 0.000

Heave Sensor:

Time Stamp: 2005-299 00:00

Comments RP to IMU
Apply Yes
Latency 0.000
DeltaX: 0.000
DeltaY: 0.000
DeltaZ: 0.000
Offset: 0.000

Manufacturer: (null)
Model: (null)
Serial Number: (null)

Pitch Sensor:
Time Stamp: 2005-299 00:00

Comments (null)
Apply Yes
Latency 0.000
Pitch offset: 0.000

Manufacturer: (null)
Model: (null)
Serial Number: (null)

Roll Sensor:

Time Stamp: 2005-299 00:00

Comments (null)
Apply Yes
Latency 0.000
Roll offset: 0.000

Manufacturer: (null)
Model: (null)
Serial Number: (null)

Draft Sensor:

Time Stamp: 2005-299 00:00

Apply Yes
Comments From S3002
Entry 1) Draft: 0.000  Speed: 0.000
Entry 2) Draft: 0.101  Speed: 2.000
Entry 3) Draft: 0.108  Speed: 3.500
Entry 4) Draft: 0.202  Speed: 4.500
Entry 5) Draft: 0.204  Speed: 6.000
Entry 6) Draft: 0.076  Speed: 7.500

Time Stamp: 2005-305 00:00

Apply Yes
Comments Steve's Calc
Entry 1) Draft: 0.000  Speed: 1.800
Entry 2) Draft: -0.020  Speed: 4.200
Entry 3) Draft: -0.020  Speed: 5.000
Entry 4) Draft: -0.060  Speed: 6.400
Entry 5) Draft: -0.020  Speed: 7.300
Entry 6) Draft: 0.000  Speed: 8.200

TPE

Time Stamp: 2007-079 00:00

Comments
Offsets corrected in POS, SDs from HSTD2007_2

Offsets

Motion sensing unit to the transducer 1
  X Head 1 0.000
  Y Head 1 0.000
  Z Head 1 0.000

Motion sensing unit to the transducer 2
  X Head 2 0.000
  Y Head 2 0.000
  Z Head 2 0.000

Navigation antenna to the transducer 1
  X Head 1 0.000
  Y Head 1 0.000
  Z Head 1 0.000

Navigation antenna to the transducer 2
  X Head 2 0.000
  Y Head 2 0.000
  Z Head 2 0.000

Roll offset of transducer number 1 0.000
Roll offset of transducer number 2 0.000

Heave Error: 0.050 or 5.000" of heave amplitude.
Measurement errors: 0.050
Motion sensing unit alignment errors
Gyro:1.000   Pitch:1.000   Roll:1.000
Gyro measurement error: 0.020
Roll measurement error: 0.020
Pitch measurement error: 0.020
Navigation measurement error: 1.000
Transducer timing error: 0.010
Navigation timing error: 0.010
Gyro timing error: 0.010
Heave timing error: 0.010
Pitch Timing Std Dev: 0.010
Roll timing error: 0.010
Sound Velocity speed measurement error: 0.000
Surface sound speed measurement error: 0.000
Tide measurement error: 0.000
Tide zoning error: 0.000
Speed over ground measurement error: 0.030
Dynamic loading measurement error: 0.150
Static draft measurement error: 0.100
Delta draft measurement error: 0.020
StdDev Comment: `éƒJ Ï…Jœ…JPō…Jªð…J …J@í…JªkJãZJÔ…Ja

Svp Sensor:

Time Stamp: 2006-121 00:00

Comments
Svp #1:
---------
Pitch Offset: 0.000
Roll Offset: 0.000
Azimuth Offset: 0.000
DeltaX: 1.376
DeltaY: -2.050
DeltaZ: 0.811

SVP #2:
---------
Pitch Offset: 0.000
Roll Offset: 0.000
Azimuth Offset: 0.000
DeltaX: 0.000
DeltaY: 0.000
DeltaZ: 0.000

Time Stamp: 2007-079 00:00
Comments (null)
Svp #1:
-------------
Pitch Offset: 0.000
Roll Offset: 0.000
Azimuth Offset: 0.000

DeltaX: 1.284
DeltaY: -1.996
DeltaZ: 0.612

SVP #2:
-------------
Pitch Offset: 0.000
Roll Offset: 0.000
Azimuth Offset: 0.000

DeltaX: 0.000
DeltaY: 0.000
DeltaZ: 0.000

_________________________________________________________

WaterLine:

Time Stamp: 2005-300 00:00

Comments RP to WL
Apply Yes
WaterLine -0.080

_________________________________________________________
Vessel Name: NRT7_S3004_Reson8125.hvf
Vessel created: The vessel file was not saved at the time this report was generated.

Depth Sensor:

Sensor Class:    Swath
Time Stamp:      2005-299 00:00

Transducer #1:
-------------
Pitch Offset:   2.040
Roll Offset:    -0.360
Azimuth Offset: -0.320

DeltaX: -1.376
DeltaY: -2.050
DeltaZ: 0.610

Manufacturer:    Reson
Model:           sb8125
Serial Number:

Depth Sensor:

Sensor Class:    Swath
Time Stamp:      2006-228 00:00

Transducer #1:
-------------
Pitch Offset:   -0.550
Roll Offset:    0.790
Azimuth Offset: -2.000

DeltaX: 1.343
DeltaY: -2.104
DeltaZ: 0.610

Manufacturer:    Reson
Model:           sb8125
Serial Number:
Depth Sensor:

Sensor Class: Swath
Time Stamp: 2006-310 00:00

Transducer #1:
-------------
Pitch Offset: -1.250
Roll Offset: 0.650
Azimuth Offset: 0.790

DeltaX: 1.343
DeltaY: -2.104
DeltaZ: 0.610

Manufacturer: Reson
Model: sb8125
Serial Number:

Depth Sensor:

Sensor Class: Swath
Time Stamp: 2006-317 00:00

Transducer #1:
-------------
Pitch Offset: -1.600
Roll Offset: 0.850
Azimuth Offset: 0.800

DeltaX: 1.343
DeltaY: -2.104
DeltaZ: 0.610

Manufacturer: Reson
Model: sb8125
Serial Number:

Navigation Sensor:

Time Stamp: 2005-299 00:00
Comments Offset applied in POS
Latency 0.000
DeltaX: 0.000
DeltaY: 0.000
DeltaZ: 0.000

Manufacturer: Applanix
Model: POSMV v4
Serial Number: (null)

Gyro Sensor:

Time Stamp: 2005-299 00:00

Comments (null)
Latency 0.000

Heave Sensor:

Time Stamp: 2005-299 00:00

Comments RP to IMU
Apply Yes
Latency -0.300
DeltaX: 0.000
DeltaY: 0.000
DeltaZ: 0.000
Offset: 0.000

Manufacturer: (null)
Model: (null)
Serial Number: (null)

Pitch Sensor:

Time Stamp: 2005-299 00:00

Comments (null)
Apply Yes
Latency 0.000
Pitch offset: 0.000

Manufacturer: (null)
Model: (null)
Serial Number: (null)

Roll Sensor:

Time Stamp: 2005-299 00:00

Comments (null)
Apply Yes
Latency 0.000
Roll offset: 0.000

Manufacturer: (null)
Model: (null)
Serial Number: (null)

Draft Sensor:

Time Stamp: 2005-299 00:00

Apply Yes
Comments From S3002
Entry 1) Draft: 0.000  Speed: 0.000
Entry 2) Draft: 0.101  Speed: 2.000
Entry 3) Draft: 0.108  Speed: 3.500
Entry 4) Draft: 0.202  Speed: 4.500
Entry 5) Draft: 0.204  Speed: 6.000
Entry 6) Draft: 0.076  Speed: 7.500

TPE

Time Stamp: 2006-310 00:00

Comments
Offsets

Motion sensing unit to the transducer 1
  X Head 1 1.343
Y Head 1 -2.104
Z Head 1 0.610

Motion sensing unit to the transducer 2
X Head 2 0.000
Y Head 2 0.000
Z Head 2 0.000

Navigation antenna to the transducer 1
X Head 1 0.000
Y Head 1 0.000
Z Head 1 0.000

Navigation antenna to the transducer 2
X Head 2 0.000
Y Head 2 0.000
Z Head 2 0.000

Roll offset of transducer number 1 0.000
Roll offset of transducer number 2 0.000

Heave Error: 0.050 or 5.000" of heave amplitude.
Measurement errors: 0.001
Motion sensing unit alignment errors
Gyro:1.000  Pitch:1.000  Roll:1.000
Gyro measurement error: 0.020
Roll measurement error: 0.020
Pitch measurement error: 0.020
Navigation measurement error: 1.000
Transducer timing error: 0.010
Navigation timing error: 0.010
Gyro timing error: 0.010
Heave timing error: 0.010
PitchTimingStdDev: 0.010
Roll timing error: 0.010
Sound Velocity speed measurement error: 4.000
Surface sound speed measurement error: 0.500
Tide measurement error: 0.020
Tide zoning error: 0.020
Speed over ground measurement error: 0.030
Dynamic loading measurement error: 0.150
Static draft measurement error: 0.100
Delta draft measurement error: 0.100
StDev Comment: `éfJ Ì…J°Jpó…J©Jp…J°Jp…J@ì…J°kJãJÓ…Ja

Svp Sensor:
Time Stamp: 2005-299 00:00

Comments (null)
Svp #1:
-------------
Pitch Offset: 0.000
Roll Offset: 0.000
Azimuth Offset: 0.000

DeltaX: -1.376
DeltaY: -2.050
DeltaZ: 0.610

SVP #2:
-------------
Pitch Offset: 0.000
Roll Offset: 0.000
Azimuth Offset: 0.000

DeltaX: 0.000
DeltaY: 0.000
DeltaZ: 0.000

Time Stamp: 2006-228 00:00

Comments (null)
Svp #1:
-------------
Pitch Offset: 0.000
Roll Offset: 0.000
Azimuth Offset: 0.000

DeltaX: 1.343
DeltaY: -2.104
DeltaZ: 0.610

SVP #2:
-------------
Pitch Offset: 0.000
Roll Offset: 0.000
Azimuth Offset: 0.000
DeltaX: 0.000  
DeltaY: 0.000  
DeltaZ: 0.000  

Time Stamp:  2006-307 00:00

Comments
Svp #1:
---------------
Pitch Offset:  0.000  
Roll Offset:  0.000  
Azimuth Offset: 0.000  

DeltaX: 0.000  
DeltaY: 0.000  
DeltaZ: 0.000  

SVP #2:
---------------
Pitch Offset:  0.000  
Roll Offset:  0.000  
Azimuth Offset: 0.000  

DeltaX: 0.000  
DeltaY: 0.000  
DeltaZ: 0.000  

Time Stamp:  2006-310 00:00

Comments
Svp #1:
---------------
Pitch Offset:  0.000  
Roll Offset:  0.000  
Azimuth Offset: 0.000  

DeltaX: 1.343  
DeltaY: -2.104  
DeltaZ: 0.610
SVP #2:
-------------
Pitch Offset:   0.000
Roll Offset:    0.000
Azimuth Offset: 0.000

DeltaX: 0.000
DeltaY: 0.000
DeltaZ: 0.000

Time Stamp:      2006-317 00:00

Comments
Svp #1:
-------------
Pitch Offset:   0.000
Roll Offset:    0.000
Azimuth Offset: 0.000

DeltaX: 1.343
DeltaY: -2.104
DeltaZ: 0.610

SVP #2:
-------------
Pitch Offset:   0.000
Roll Offset:    0.000
Azimuth Offset: 0.000

DeltaX: 0.000
DeltaY: 0.000
DeltaZ: 0.000

WaterLine:

Time Stamp:      2005-300 00:00

Comments RP to WL
Apply Yes
WaterLine -0.080
Vessel Name: NRT7_S3004_SB.hvf
Vessel created: The vessel file was not saved at the time this report was generated.

Depth Sensor:

Sensor Class: Swath
Time Stamp: 2006-274 00:00

Transduer #1:
------------
Pitch Offset: 0.000
Roll Offset: 0.000
Azimuth Offset: 0.000
DeltaX: -0.276
DeltaY: 0.040
DeltaZ: 0.255

Manufacturer: Odom
Model: oecv
Serial Number:

Navigation Sensor:

Time Stamp: 2005-299 00:00

Comments Offset applied in POS
Latency 0.040
DeltaX: 0.000
DeltaY: 0.000
DeltaZ: 0.000

Manufacturer: Applanix
Model: POSMV v4
Serial Number: (null)

Gyro Sensor:

Time Stamp: 2005-299 00:00
Heave Sensor:

Time Stamp: 2005-299 00:00

Comments RP to IMU
Apply Yes
Latency 0.000
DeltaX: 0.000
DeltaY: 0.000
DeltaZ: 0.000
Offset: 0.000

Manufacturer: (null)
Model: (null)
Serial Number: (null)

Pitch Sensor:

Time Stamp: 2005-299 00:00

Comments (null)
Apply Yes
Latency 0.000
Pitch offset: 0.000

Manufacturer: (null)
Model: (null)
Serial Number: (null)

Roll Sensor:

Time Stamp: 2005-299 00:00

Comments (null)
Apply Yes
Latency 0.000
Roll offset: 0.000

Manufacturer: (null)
Model: (null)
Serial Number: (null)

Draft Sensor:

Time Stamp: 2005-299 00:00

Apply Yes
Comments From S3002
Entry 1) Draft: 0.000   Speed: 0.000
Entry 2) Draft: 0.101   Speed: 2.000
Entry 3) Draft: 0.108   Speed: 3.500
Entry 4) Draft: 0.202   Speed: 4.500
Entry 5) Draft: 0.204   Speed: 6.000
Entry 6) Draft: 0.076   Speed: 7.500

Time Stamp: 2005-305 00:00

Apply Yes
Comments Steve's Calc
Entry 1) Draft: 0.000   Speed: 1.800
Entry 2) Draft: -0.020  Speed: 4.200
Entry 3) Draft: -0.020  Speed: 5.000
Entry 4) Draft: -0.060  Speed: 6.400
Entry 5) Draft: -0.020  Speed: 7.300
Entry 6) Draft: 0.000   Speed: 8.200

Svp Sensor:

Time Stamp: 2006-121 00:00

Comments
Svp #1:
-------------
Pitch Offset: 0.000
Roll Offset: 0.000
Azimuth Offset: 0.000

DeltaX: 1.376
DeltaY: -2.050
DeltaZ: 0.811

SVP #2:
-------------
Pitch Offset: 0.000
Roll Offset: 0.000
Azimuth Offset: 0.000

DeltaX: 0.000
DeltaY: 0.000
DeltaZ: 0.000

Time Stamp: 2006-253 00:00

Comments
Svp #1:
-------------
Pitch Offset: 0.000
Roll Offset: 0.000
Azimuth Offset: 0.000

DeltaX: -0.276
DeltaY: 0.040
DeltaZ: 0.255

SVP #2:
-------------
Pitch Offset: 0.000
Roll Offset: 0.000
Azimuth Offset: 0.000

DeltaX: 0.000
DeltaY: 0.000
DeltaZ: 0.000

Time Stamp: 2006-273 00:00

Comments
Svp #1:
Pitch Offset:   0.000  
Roll Offset:    0.000 
Azimuth Offset: 0.000 

DeltaX: 0.000  
DeltaY: 0.000  
DeltaZ: 0.000 

SVP #2:  
-----------  
Pitch Offset:   0.000  
Roll Offset:    0.000  
Azimuth Offset: 0.000 

DeltaX: 0.000 
DeltaY: 0.000 
DeltaZ: 0.000 

Time Stamp:      2006-274 00:00 

Comments 
Svp #1:  
-----------  
Pitch Offset:   0.000  
Roll Offset:    0.000  
Azimuth Offset: 0.000 

DeltaX: -0.276  
DeltaY: 0.040 
DeltaZ: 0.255 

SVP #2:  
-----------  
Pitch Offset:   0.000  
Roll Offset:    0.000  
Azimuth Offset: 0.000 

DeltaX: 0.000 
DeltaY: 0.000 
DeltaZ: 0.000
WaterLine:

Time Stamp: 2005-300 00:00

Comments RP to WL
Apply Yes
WaterLine -0.080
APPENDIX III
“1” (bit on bow)

“2” (port POS M/V antenna)

“3” (stbd POS M/V antenna)

“5” (IMU)

“00” Top-aft-inside coming of hatch in cabin

“7” Punch mark on forward side of mounting plate

“9” Punch mark on top of arm

“11” Punch mark on aft side of mounting plate

“13” Center of J-arm up-right

“15” stbd-stern bit

“4” Punch on forward lower plate

“6” Punch on top of arm

“8” Punch on aft lower plate

“10” port-stern bit

“Stern” bottom of V-hull
J-Arm

Port Sonar Arm

Stbd Sonar Arm

FWD

FWD

144.0 cm

129.5 cm

“4”

“6”

“8”

“7”

“11”

“9”
<table>
<thead>
<tr>
<th>Point Name</th>
<th>Northing</th>
<th>Easting</th>
<th>Elevation</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>for/aft</td>
<td>port/stb</td>
<td>up/down</td>
</tr>
<tr>
<td>AMC</td>
<td>16.3631</td>
<td>-11.4689</td>
<td>0.67</td>
</tr>
<tr>
<td>BOWKEEL</td>
<td>4.2287</td>
<td>-0.0188</td>
<td>0.21</td>
</tr>
<tr>
<td>IMU</td>
<td>0.097</td>
<td>0.1113</td>
<td>-0.09</td>
</tr>
<tr>
<td>RP</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>STERNKEEL</td>
<td>-4.0363</td>
<td>-0.0188</td>
<td>-0.35</td>
</tr>
<tr>
<td>TP1</td>
<td>-0.9354</td>
<td>6.0829</td>
<td>0.52</td>
</tr>
<tr>
<td>1</td>
<td>4.632</td>
<td>0.001</td>
<td>1.29</td>
</tr>
<tr>
<td>2</td>
<td>1.256</td>
<td>-0.7956</td>
<td>2.47</td>
</tr>
<tr>
<td>3</td>
<td>1.2496</td>
<td>0.7606</td>
<td>2.47</td>
</tr>
<tr>
<td>11</td>
<td>-2.1143</td>
<td>1.3752</td>
<td>-0.42</td>
</tr>
<tr>
<td>9</td>
<td>-2.0498</td>
<td>1.3755</td>
<td>0.98</td>
</tr>
<tr>
<td>7</td>
<td>-1.8818</td>
<td>1.3729</td>
<td>-0.44</td>
</tr>
<tr>
<td>10</td>
<td>-2.9992</td>
<td>-1.1347</td>
<td>0.98</td>
</tr>
<tr>
<td>13</td>
<td>-2.548</td>
<td>0.5653</td>
<td>1.49</td>
</tr>
<tr>
<td>15</td>
<td>-2.9967</td>
<td>1.1135</td>
<td>1</td>
</tr>
</tbody>
</table>

Note: Mounting arm was modified in summer/fall 2006. The port side arm became the stbd-side arm after the modification. We assume the position of the deployed pole did not change. BJW

The surveyed points were treated as the following in the new diagram and the signs and values adjusted accordingly:

8=7
6=9
4=11

<table>
<thead>
<tr>
<th>for/aft</th>
<th>port/stbd</th>
<th>up/down</th>
</tr>
</thead>
<tbody>
<tr>
<td>7 to LW3D</td>
<td>-0.1143</td>
<td>-0.0889</td>
</tr>
<tr>
<td>RP to LWC3D F</td>
<td>-1.9961</td>
<td>1.284</td>
</tr>
</tbody>
</table>
**Conductivity Calibration Report**

<table>
<thead>
<tr>
<th>Customer:</th>
<th>NOAA - NRT-1</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Job Number:</strong></td>
<td>44256</td>
</tr>
<tr>
<td><strong>Model Number</strong></td>
<td>SBE 19Plus</td>
</tr>
</tbody>
</table>

Conductivity sensors are normally calibrated ‘as received’, without cleaning or adjustments, allowing a determination of sensor drift. If the calibration identifies a problem or indicates cell cleaning is necessary, then a second calibration is performed after work is completed. The ‘as received’ calibration is not performed if the sensor is damaged or non-functional, or by customer request.

An ‘as received’ calibration certificate is provided, listing the coefficients used to convert sensor frequency to conductivity. Users must choose whether the ‘as received’ calibration or the previous calibration better represents the sensor condition during deployment. In SEASOFT enter the chosen coefficients using the program SEACON. The coefficient ‘slope’ allows small corrections for drift between calibrations (consult the SEASOFT manual). Calibration coefficients obtained after a repair or cleaning apply only to subsequent data.

<table>
<thead>
<tr>
<th><strong>'AS RECEIVED CALIBRATION'</strong></th>
<th>☑️ Performed</th>
<th>☐️ Not Performed</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Date:</strong></td>
<td>1/9/2007</td>
<td><strong>Drift since last cal:</strong></td>
</tr>
<tr>
<td><strong>Comments:</strong></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>'CALIBRATION AFTER CLEANING &amp; REPLATINIZING'</strong></th>
<th>☐️ Performed</th>
<th>☑️ Not Performed</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Date:</strong></td>
<td></td>
<td><strong>Drift since Last cal:</strong></td>
</tr>
<tr>
<td><strong>Comments:</strong></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

*Measured at 3.0 S/m

Cell cleaning and electrode replatinizing tend to 'reset' the conductivity sensor to its original condition. Lack of drift in post-cleaning-calibration indicates geometric stability of the cell and electrical stability of the sensor circuit.
### SBE19plus Conductivity Calibration Data

PSS 1978: $C(35,15,0) = 4.2914$ Siemens/meter

#### Coefficients:

- $g = -1.054221e+000$
- $h = 1.391571e-001$
- $i = -2.948637e-004$
- $j = 3.995315e-005$

- $CPcor = -9.5700e-008$
- $CTcor = 3.2500e-006$

#### Table

<table>
<thead>
<tr>
<th>Bath Temp (ITS-90)</th>
<th>Bath Sal (PSU)</th>
<th>Bath Cond (Siemens/m)</th>
<th>Inst Freq (Hz)</th>
<th>Inst Cond (Siemens/m)</th>
<th>Residual (Siemens/m)</th>
</tr>
</thead>
<tbody>
<tr>
<td>22.0000</td>
<td>0.0000</td>
<td>0.0000</td>
<td>2757.46</td>
<td>0.0000</td>
<td>0.0000</td>
</tr>
<tr>
<td>1.0000</td>
<td>34.6447</td>
<td>2.96269</td>
<td>5381.02</td>
<td>2.9627</td>
<td>-0.00001</td>
</tr>
<tr>
<td>4.5000</td>
<td>34.6250</td>
<td>3.26845</td>
<td>5581.53</td>
<td>3.2685</td>
<td>0.00001</td>
</tr>
<tr>
<td>14.9999</td>
<td>34.5835</td>
<td>4.24606</td>
<td>6178.31</td>
<td>4.2461</td>
<td>0.00003</td>
</tr>
<tr>
<td>18.5000</td>
<td>34.5748</td>
<td>4.58978</td>
<td>6374.58</td>
<td>4.5898</td>
<td>0.00000</td>
</tr>
<tr>
<td>24.0000</td>
<td>34.5653</td>
<td>5.14540</td>
<td>6679.36</td>
<td>5.1454</td>
<td>-0.00003</td>
</tr>
<tr>
<td>29.0000</td>
<td>34.5601</td>
<td>5.66506</td>
<td>6952.02</td>
<td>5.6650</td>
<td>-0.00002</td>
</tr>
<tr>
<td>32.5001</td>
<td>34.5572</td>
<td>6.03591</td>
<td>7140.05</td>
<td>6.0359</td>
<td>0.00002</td>
</tr>
</tbody>
</table>

\[ f = \text{Inst Freq} / 1000.0 \]

\[ \text{Conductivity} = \frac{g + hf^2 + if^3 + jf^4}{1 + \delta t + \epsilon p} \] Siemens/meter

\[ t = \text{temperature}[^\circ\text{C}] \]

\[ p = \text{pressure}[^\text{decibars}] \]

\[ \delta = CTcor \]

\[ \epsilon = CPcor \]

\[ \text{Residual} = \text{instrument conductivity} - \text{bath conductivity} \]
SENSOR SERIAL NUMBER: 4677  
CALIBRATION DATE: 04-Jan-07

SBE19plus PRESSURE CALIBRATION DATA  
508 psia S/N 6135

COEFFICIENTS:

<table>
<thead>
<tr>
<th>PA0</th>
<th>1.741331e-001</th>
</tr>
</thead>
<tbody>
<tr>
<td>PA1</td>
<td>1.549722e-003</td>
</tr>
<tr>
<td>PA2</td>
<td>9.22321e-012</td>
</tr>
<tr>
<td>PTEMA0</td>
<td>-7.930081e+001</td>
</tr>
<tr>
<td>PTEMA1</td>
<td>4.829264e+001</td>
</tr>
<tr>
<td>PTEMA2</td>
<td>-3.740742e+001</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>PTCA0</th>
<th>5.152023e+005</th>
</tr>
</thead>
<tbody>
<tr>
<td>PTCA1</td>
<td>9.012761e+000</td>
</tr>
<tr>
<td>PTCA2</td>
<td>-1.728316e-001</td>
</tr>
<tr>
<td>PTCB0</td>
<td>2.429287e+001</td>
</tr>
<tr>
<td>PTCB1</td>
<td>-6.250000e-004</td>
</tr>
<tr>
<td>PTCB2</td>
<td>0.000000e+000</td>
</tr>
</tbody>
</table>

PRESSURE SPAN CALIBRATION

<table>
<thead>
<tr>
<th>PRESSURE (PSIA)</th>
<th>OUTPUT</th>
<th>THERMISTOR</th>
<th>COMPUTED PRESSURE</th>
<th>ERROR %FSR</th>
</tr>
</thead>
<tbody>
<tr>
<td>14.67</td>
<td>524663.0</td>
<td>2.1</td>
<td>14.67</td>
<td>-0.00</td>
</tr>
<tr>
<td>104.95</td>
<td>582845.0</td>
<td>2.1</td>
<td>104.93</td>
<td>-0.01</td>
</tr>
<tr>
<td>204.98</td>
<td>647223.0</td>
<td>2.1</td>
<td>204.86</td>
<td>-0.02</td>
</tr>
<tr>
<td>304.92</td>
<td>711614.0</td>
<td>2.1</td>
<td>304.90</td>
<td>-0.00</td>
</tr>
<tr>
<td>404.93</td>
<td>775925.0</td>
<td>2.1</td>
<td>404.89</td>
<td>-0.01</td>
</tr>
<tr>
<td>504.92</td>
<td>840208.0</td>
<td>2.1</td>
<td>504.91</td>
<td>-0.00</td>
</tr>
<tr>
<td>404.90</td>
<td>775962.0</td>
<td>2.1</td>
<td>404.95</td>
<td>0.01</td>
</tr>
<tr>
<td>304.89</td>
<td>711660.0</td>
<td>2.1</td>
<td>304.97</td>
<td>0.02</td>
</tr>
<tr>
<td>204.93</td>
<td>647285.0</td>
<td>2.1</td>
<td>204.96</td>
<td>0.01</td>
</tr>
<tr>
<td>104.93</td>
<td>582887.0</td>
<td>2.1</td>
<td>104.99</td>
<td>0.01</td>
</tr>
<tr>
<td>14.67</td>
<td>524664.0</td>
<td>2.1</td>
<td>14.67</td>
<td>-0.00</td>
</tr>
</tbody>
</table>

THERMAL CORRECTION

<table>
<thead>
<tr>
<th>TEMP (ITS90)</th>
<th>OUTPUT</th>
<th>SPAN (mV)</th>
</tr>
</thead>
<tbody>
<tr>
<td>32.50</td>
<td>2.36</td>
<td>524972.58</td>
</tr>
<tr>
<td>29.00</td>
<td>2.28</td>
<td>524966.94</td>
</tr>
<tr>
<td>24.00</td>
<td>2.18</td>
<td>524974.66</td>
</tr>
<tr>
<td>18.50</td>
<td>2.06</td>
<td>524966.99</td>
</tr>
<tr>
<td>15.00</td>
<td>1.98</td>
<td>524954.54</td>
</tr>
<tr>
<td>4.50</td>
<td>1.76</td>
<td>524895.24</td>
</tr>
<tr>
<td>1.00</td>
<td>1.69</td>
<td>524865.65</td>
</tr>
</tbody>
</table>

y = thermistor output; t = PTEMA0 + PTEMA1 * y + PTEMA2 * y^2

x = pressure output - PTCA0 - PTCA1 * t - PTCA2 * t^2

n = x * PTCB0 / (PTCB0 + PTCB1 * t + PTCB2 * t^2)

pressure (psia) = PA0 + PA1 * n + PA2 * n^2

Date, Avg Delta P %FS

04-Jan-07    0.00
**SBE19plus TEMPERATURE CALIBRATION DATA**

**ITS-90 TEMPERATURE SCALE**

### ITS-90 COEFFICIENTS

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>a0</td>
<td>1.162054e-003</td>
</tr>
<tr>
<td>a1</td>
<td>2.738619e-004</td>
</tr>
<tr>
<td>a2</td>
<td>-9.432152e-007</td>
</tr>
<tr>
<td>a3</td>
<td>1.791934e-007</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>BATH TEMP (ITS-90)</th>
<th>INSTRUMENT OUTPUT(n)</th>
<th>INST TEMP (ITS-90)</th>
<th>RESIDUAL (ITS-90)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.0000</td>
<td>693723.056</td>
<td>1.0001</td>
<td>0.0001</td>
</tr>
<tr>
<td>4.5000</td>
<td>620453.352</td>
<td>4.4998</td>
<td>-0.0002</td>
</tr>
<tr>
<td>14.9999</td>
<td>435193.141</td>
<td>15.0002</td>
<td>0.0003</td>
</tr>
<tr>
<td>18.5000</td>
<td>384587.141</td>
<td>18.4998</td>
<td>-0.0002</td>
</tr>
<tr>
<td>24.0000</td>
<td>315243.225</td>
<td>24.0000</td>
<td>0.0000</td>
</tr>
<tr>
<td>29.0000</td>
<td>261952.225</td>
<td>28.9998</td>
<td>-0.0002</td>
</tr>
<tr>
<td>32.5001</td>
<td>229534.817</td>
<td>32.5002</td>
<td>0.0001</td>
</tr>
</tbody>
</table>

\[
MV = (n - 524288) / 1.6e+007
\]

\[
R = (MV * 2.900e+009 + 1.024e+008) / (2.048e+004 - MV * 2.0e+005)
\]

Temperature ITS-90 = \[
\frac{1}{a0 + a1 \ln(R)} + a2 \ln^2(R) + a3 \ln^3(R)\] - 273.15 (°C)

Residual = instrument temperature - bath temperature

![Graph showing residual vs. temperature with data points for 02-Aug-05: 1.42 mdeg C and 09-Jan-07: 0.00 mdeg C.](image)
Customer Information:

Company: NOAA - NRT-1
Contact: Steve Brodet
PO Number: TBD

Serial Number: 05M0684
Model Number: SBE 05T

Services Requested:
1. Evaluate/Repair Instrumentation.

Problems Found:

Services Performed:
1. Performed initial diagnostic evaluation.

Special Notes:
### Service Report

| RMA Number | 44256 |

#### Customer Information:

<table>
<thead>
<tr>
<th>Company</th>
<th>NOAA - NRT-1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Contact</td>
<td>Steve Brodet</td>
</tr>
<tr>
<td>PO Number</td>
<td>TBD</td>
</tr>
</tbody>
</table>

#### Serial Number

- **19P37217-4677**

#### Model Number

- **SBE 19Plus**

#### Services Requested:

1. Evaluate/Repair Instrumentation.
2. Perform Routine Calibration Service.

#### Problems Found:

- 

#### Services Performed:

1. Performed initial diagnostic evaluation.
2. Upgraded firmware to most current revision (see special notes).*
3. Calibrated the pressure sensor.
5. Performed complete system check and full diagnostic evaluation.

#### Special Notes:

* Updated the EPROM to version 1.6b.
Temperature Calibration Report

<table>
<thead>
<tr>
<th>Customer:</th>
<th>NOAA - NRT-1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Job Number:</td>
<td>44256</td>
</tr>
<tr>
<td>Date of Report:</td>
<td>1/9/2007</td>
</tr>
<tr>
<td>Model Number:</td>
<td>SBE 19Plus</td>
</tr>
<tr>
<td>Serial Number:</td>
<td>19P37217-4677</td>
</tr>
</tbody>
</table>

Temperature sensors are normally calibrated 'as received', without adjustments, allowing a determination sensor drift. If the calibration identifies a problem, then a second calibration is performed after work is completed. The 'as received' calibration is not performed if the sensor is damaged or non-functional, or by customer request.

An 'as received' calibration certificate is provided, listing coefficients to convert sensor frequency to temperature. Users must choose whether the 'as received' calibration or the previous calibration better represents the sensor condition during deployment. In SEASOFT enter the chosen coefficients using the program SEACON. The coefficient 'offset' allows a small correction for drift between calibrations (consult the SEASOFT manual). Calibration coefficients obtained after a repair apply only to subsequent data.

**'AS RECEIVED CALIBRATION'**

<table>
<thead>
<tr>
<th>Date:</th>
<th>1/9/2007</th>
</tr>
</thead>
<tbody>
<tr>
<td>Drift since last cal:</td>
<td>-0.00099 Degrees Celsius/year</td>
</tr>
<tr>
<td>Comments:</td>
<td></td>
</tr>
</tbody>
</table>

**'CALIBRATION AFTER REPAIR'**

<table>
<thead>
<tr>
<th>Date:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Drift since Last cal:</td>
</tr>
<tr>
<td>Comments:</td>
</tr>
</tbody>
</table>
## DIGIBAR CALIBRATION REPORT

**Version 1.0 (c) 2004**

**ODOM HYDROGRAPHIC SYSTEMS, Inc.**

### STANDARD DEL GROSSO H₂O

<table>
<thead>
<tr>
<th>TEMP (°C)</th>
<th>VELOCITY</th>
<th>MEASURED</th>
<th>RES_VEL</th>
<th>OBS-CAL</th>
<th>TEMP (°C)</th>
<th>VELOCITY</th>
<th>MEASURED</th>
<th>RES_VEL</th>
<th>OBS-CAL</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>FREQUENCY</td>
<td></td>
<td></td>
<td></td>
<td>FREQUENCY</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4.00</td>
<td>1421.62</td>
<td>5542.75</td>
<td>1421.68</td>
<td>0.06</td>
<td>17.50</td>
<td>1474.38</td>
<td>5743.90</td>
<td>1474.43</td>
<td>0.05</td>
</tr>
<tr>
<td>4.50</td>
<td>1423.90</td>
<td>5551.28</td>
<td>1423.91</td>
<td>0.01</td>
<td>18.00</td>
<td>1476.01</td>
<td>5750.29</td>
<td>1476.10</td>
<td>0.09</td>
</tr>
<tr>
<td>5.00</td>
<td>1426.15</td>
<td>5559.90</td>
<td>1426.17</td>
<td>0.02</td>
<td>18.50</td>
<td>1477.62</td>
<td>5756.37</td>
<td>1477.70</td>
<td>0.08</td>
</tr>
<tr>
<td>5.50</td>
<td>1428.38</td>
<td>5567.88</td>
<td>1428.27</td>
<td>-0.11</td>
<td>19.00</td>
<td>1479.21</td>
<td>5762.33</td>
<td>1479.26</td>
<td>0.05</td>
</tr>
<tr>
<td>6.00</td>
<td>1430.58</td>
<td>5576.13</td>
<td>1430.43</td>
<td>-0.15</td>
<td>19.50</td>
<td>1480.77</td>
<td>5768.23</td>
<td>1480.81</td>
<td>0.04</td>
</tr>
<tr>
<td>6.50</td>
<td>1432.75</td>
<td>5585.07</td>
<td>1432.77</td>
<td>0.02</td>
<td>20.00</td>
<td>1482.32</td>
<td>5774.42</td>
<td>1482.43</td>
<td>0.11</td>
</tr>
<tr>
<td>7.00</td>
<td>1434.90</td>
<td>5592.88</td>
<td>1434.82</td>
<td>-0.08</td>
<td>20.50</td>
<td>1483.84</td>
<td>5780.35</td>
<td>1483.99</td>
<td>0.14</td>
</tr>
<tr>
<td>7.50</td>
<td>1437.02</td>
<td>5601.20</td>
<td>1437.00</td>
<td>-0.02</td>
<td>21.00</td>
<td>1485.35</td>
<td>5785.90</td>
<td>1485.44</td>
<td>0.10</td>
</tr>
<tr>
<td>8.00</td>
<td>1439.12</td>
<td>5609.24</td>
<td>1439.11</td>
<td>0.00</td>
<td>21.50</td>
<td>1486.83</td>
<td>5791.72</td>
<td>1486.97</td>
<td>0.14</td>
</tr>
<tr>
<td>8.50</td>
<td>1441.19</td>
<td>5617.42</td>
<td>1441.26</td>
<td>0.07</td>
<td>22.00</td>
<td>1488.29</td>
<td>5797.10</td>
<td>1488.38</td>
<td>0.09</td>
</tr>
<tr>
<td>9.00</td>
<td>1443.23</td>
<td>5625.08</td>
<td>1443.27</td>
<td>0.03</td>
<td>22.50</td>
<td>1489.74</td>
<td>5802.69</td>
<td>1489.84</td>
<td>0.11</td>
</tr>
<tr>
<td>9.50</td>
<td>1445.25</td>
<td>5632.87</td>
<td>1445.31</td>
<td>0.06</td>
<td>23.00</td>
<td>1491.16</td>
<td>5808.02</td>
<td>1491.24</td>
<td>0.08</td>
</tr>
<tr>
<td>10.00</td>
<td>1447.25</td>
<td>5640.51</td>
<td>1447.31</td>
<td>0.06</td>
<td>23.50</td>
<td>1492.56</td>
<td>5813.29</td>
<td>1492.62</td>
<td>0.06</td>
</tr>
<tr>
<td>10.50</td>
<td>1449.22</td>
<td>5647.97</td>
<td>1449.27</td>
<td>0.05</td>
<td>24.00</td>
<td>1493.95</td>
<td>5818.91</td>
<td>1494.10</td>
<td>0.15</td>
</tr>
<tr>
<td>11.00</td>
<td>1451.17</td>
<td>5655.08</td>
<td>1451.13</td>
<td>-0.04</td>
<td>24.50</td>
<td>1495.32</td>
<td>5824.07</td>
<td>1495.45</td>
<td>0.14</td>
</tr>
<tr>
<td>11.50</td>
<td>1453.09</td>
<td>5662.46</td>
<td>1453.07</td>
<td>-0.03</td>
<td>25.00</td>
<td>1496.66</td>
<td>5829.18</td>
<td>1496.79</td>
<td>0.13</td>
</tr>
<tr>
<td>12.00</td>
<td>1454.99</td>
<td>5670.05</td>
<td>1455.06</td>
<td>0.07</td>
<td>25.50</td>
<td>1497.99</td>
<td>5834.29</td>
<td>1498.13</td>
<td>0.14</td>
</tr>
<tr>
<td>12.50</td>
<td>1456.87</td>
<td>5677.09</td>
<td>1456.91</td>
<td>0.03</td>
<td>26.00</td>
<td>1499.30</td>
<td>5839.08</td>
<td>1499.39</td>
<td>0.09</td>
</tr>
<tr>
<td>13.00</td>
<td>1458.72</td>
<td>5684.34</td>
<td>1458.81</td>
<td>0.08</td>
<td>26.50</td>
<td>1500.59</td>
<td>5843.82</td>
<td>1500.63</td>
<td>0.04</td>
</tr>
<tr>
<td>13.50</td>
<td>1460.55</td>
<td>5690.79</td>
<td>1460.50</td>
<td>-0.06</td>
<td>27.00</td>
<td>1501.86</td>
<td>5848.76</td>
<td>1501.93</td>
<td>0.07</td>
</tr>
<tr>
<td>14.00</td>
<td>1462.36</td>
<td>5698.81</td>
<td>1462.39</td>
<td>0.03</td>
<td>27.50</td>
<td>1503.11</td>
<td>5853.30</td>
<td>1503.12</td>
<td>0.01</td>
</tr>
<tr>
<td>14.50</td>
<td>1464.14</td>
<td>5704.80</td>
<td>1464.17</td>
<td>0.03</td>
<td>28.00</td>
<td>1504.35</td>
<td>5858.26</td>
<td>1504.42</td>
<td>0.07</td>
</tr>
<tr>
<td>15.00</td>
<td>1465.91</td>
<td>5711.42</td>
<td>1465.91</td>
<td>0.00</td>
<td>28.50</td>
<td>1505.56</td>
<td>5862.62</td>
<td>1505.56</td>
<td>0.00</td>
</tr>
<tr>
<td>15.50</td>
<td>1467.65</td>
<td>5718.18</td>
<td>1467.68</td>
<td>0.04</td>
<td>29.00</td>
<td>1506.76</td>
<td>5867.19</td>
<td>1506.76</td>
<td>0.00</td>
</tr>
<tr>
<td>16.00</td>
<td>1469.36</td>
<td>5724.96</td>
<td>1469.46</td>
<td>0.10</td>
<td>29.50</td>
<td>1507.94</td>
<td>5871.63</td>
<td>1507.92</td>
<td>-0.02</td>
</tr>
<tr>
<td>16.50</td>
<td>1471.06</td>
<td>5731.30</td>
<td>1471.12</td>
<td>0.07</td>
<td>30.00</td>
<td>1509.10</td>
<td>5876.34</td>
<td>1509.16</td>
<td>0.05</td>
</tr>
<tr>
<td>17.00</td>
<td>1472.73</td>
<td>5737.72</td>
<td>1472.81</td>
<td>0.08</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

---

**Odom Hydrographic Systems, Inc.**

1450 Seaboard Avenue, Baton Rouge, Louisiana 70810-6261, USA

Telephone: (225)-769-3051; Facsimile: (225)-766-5122

E-mail: email@odomhydrographic.com; HTTP: www.odomhydrographic.com
DIGIBAR CALIBRATION REPORT
version 1.0 (c) 2004
ODOM HYDROGRAPHIC SYSTEMS, Inc.

Date: Aug 05, 2006
Serial #: SN98351-080505

Burn these numbers to EPROM:

Gradient
Intercept

3357
319

Calibration Graph

TEMPERATURE (CENTIGRADE)

The instruments used in this calibration have been calibrated to the published manufacturer specifications using standards traceable to NIST, to consensus standards, to ratio methods, or to acceptable values of natural physical constants that meets the requirements of ANSI/NCSL Z540-1, ISO 9001, ISO 10012 and ISO 17025. Certificate/traceability numbers: 0002-2655.00-23491-001, 0002-2655.00-23491-002. ID#s:294,295,762,172,56

Odom Hydrographic Systems, Inc.
1450 Seaboard Avenue, Baton Rouge, Louisiana 70810-5081, USA
Telephone: (225) 789-3001, Facsimile: (225) 786-4122
E-mail: email@odomhydrographic.com, HTTP: www.odomhydrographic.com
### SYSTEM INFORMATION

<table>
<thead>
<tr>
<th>Vessel:</th>
<th>NRT7 (s3004)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Date:</td>
<td>3/22/2007</td>
</tr>
<tr>
<td>Dn:</td>
<td>81</td>
</tr>
<tr>
<td>Personnel:</td>
<td>LTJG Welton, PS Brodet, PS Gostnell, PS Turner</td>
</tr>
</tbody>
</table>

| PCS Serial # | 2233 |
| IP Address:  | 129.100.1.231 |

**POS controller Version (Use Menu Help > About)**: POSView 3.3.2.2

**POS Version (Use Menu View > Statistics)**: MV320 Ver4

**GPS Receivers**

- Primary Receiver: SN 60008125
- Secondary Receiver: SN 60001853

### CALIBRATION AREA

**Location:** Patuxant River, MD (Solomons)

<table>
<thead>
<tr>
<th>Approximate Position:</th>
<th>Lat D M S</th>
<th>Lon D M S</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>38 18 50</td>
<td>76 26 42</td>
</tr>
</tbody>
</table>

**DGPS Beacon Station:** Annapolis, MD

| Frequency: | 301 kHZ |

**Satellite Constellation**

- **Primary GPS (Port Antenna)**
  - HDOP: 0.862
  - VDOP: 1.188
  - Satellites in Use: 9
    - 2, 4, 5, 9, 12, 17, 20, 23, 28
  - PDOP: 1.736

**Note:** Secondary GPS satellite constellation and number of satellites were exactly the same as the Primary GPS.
POS/MV CONFIGURATION

Settings

Gams Parameter Setup (Use Settings > Installation > GAMS Installation)

<table>
<thead>
<tr>
<th>User Entries, Pre-Calibration</th>
<th>Baseline Vector</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.559 Two Antenna Separation (m)</td>
<td>-0.008 X Component (m)</td>
</tr>
<tr>
<td>0.50 Heading Calibration Threshold</td>
<td>1.559 Y Component (m)</td>
</tr>
<tr>
<td>0 Heading Correction</td>
<td>0.017 Z Component (m)</td>
</tr>
</tbody>
</table>

Configuration Notes:

POS/MV CALIBRATION

Calibration Procedure: (Refer to POS MV V3 Installation and Operation Guide, 4-25)

Start time: 13:21 UTC
End time: 13:26 UTC
Heading accuracy achieved for calibration: 0.031

Calibration Results:

Gams Parameter Setup (Use Settings > Installation > GAMS Installation)

<table>
<thead>
<tr>
<th>POS/MV Post-Calibration Values</th>
<th>Baseline Vector</th>
</tr>
</thead>
<tbody>
<tr>
<td>3.27 Two Antenna Separation (m)</td>
<td>-0.042 X Component (m)</td>
</tr>
<tr>
<td>0.50 Heading Calibration Threshold</td>
<td>3.27 Y Component (m)</td>
</tr>
<tr>
<td>0 Heading Correction</td>
<td>0.011 Z Component (m)</td>
</tr>
</tbody>
</table>

GAMS Status Online? yes
Save Settings? yes

Calibration Notes:

Save POS Settings on PC (Use File > Store POS Settings on PC)

File Name: 2.22.2007.nvm
The POS/MV uses a Right-Hand Orthogonal Reference System

The right-hand orthogonal system defines the following:

- The x-axis is in the fore-aft direction in the appropriate reference frame.
- The y-axis is perpendicular to the x-axis and points towards the right (starboard) side in the appropriate reference frame.
- The z-axis points downwards in the appropriate reference frame.

The POS/MV uses a Tate-Bryant Rotation Sequence

Apply the rotation in the following order to bring the two frames of reference into complete alignment:

a) Heading rotation - apply a right-hand screw rotation $\theta_z$ about the z-axis to align one frame with the other.

b) Pitch rotation - apply a right-hand screw rotation $\theta_y$ about the once-rotated y-axis to align one frame with the other.

c) Roll rotation - apply a right-hand screw rotation $\theta_x$ about the twice-rotated x-axis to align one frame with the other.

NOTE:

GENERAL GUIDANCE

The POS/MV uses a Right-Hand Orthogonal Reference System

The right-hand orthogonal system defines the following:

- The x-axis is in the fore-aft direction in the appropriate reference frame.
- The y-axis is perpendicular to the x-axis and points towards the right (starboard) side in the appropriate reference frame.
- The z-axis points downwards in the appropriate reference frame.

The POS/MV uses a Tate-Bryant Rotation Sequence

Apply the rotation in the following order to bring the two frames of reference into complete alignment:

a) Heading rotation - apply a right-hand screw rotation $\theta_z$ about the z-axis to align one frame with the other.

b) Pitch rotation - apply a right-hand screw rotation $\theta_y$ about the once-rotated y-axis to align one frame with the other.

c) Roll rotation - apply a right-hand screw rotation $\theta_x$ about the twice-rotated x-axis to align one frame with the other.

NOTE:

GENERAL GUIDANCE

The POS/MV uses a Right-Hand Orthogonal Reference System

The right-hand orthogonal system defines the following:

- The x-axis is in the fore-aft direction in the appropriate reference frame.
- The y-axis is perpendicular to the x-axis and points towards the right (starboard) side in the appropriate reference frame.
- The z-axis points downwards in the appropriate reference frame.

The POS/MV uses a Tate-Bryant Rotation Sequence

Apply the rotation in the following order to bring the two frames of reference into complete alignment:

a) Heading rotation - apply a right-hand screw rotation $\theta_z$ about the z-axis to align one frame with the other.

b) Pitch rotation - apply a right-hand screw rotation $\theta_y$ about the once-rotated y-axis to align one frame with the other.

c) Roll rotation - apply a right-hand screw rotation $\theta_x$ about the twice-rotated x-axis to align one frame with the other.
Heave Filter (Use Settings > Heave)

Events (Use Settings > Events)

Time Sync (Use Settings > Time Sync)

Installation (Use Settings > Installation)
GPS Receiver Configuration (Use Settings > Installation > GPS Receiver Configuration)

Primary GPS Receiver

Secondary GPS Receiver
Appendix V
HYDROGRAPHIC SYSTEMS READINESS REVIEW MEMO

July 27, 2007

MEMORANDUM FOR: CDR Gerd Glang, NOAA
Chief, Hydrographic Surveys Division

LCDR Lawrence Krepp, NOAA
Chief, Navigation Response Branch

Robert Downs
Acting Chief, Hydrographic Systems and Technology Programs

LCDR Shepard Smith, NOAA
Chief, Atlantic Hydrographic Branch

FROM: LTJG Briana Welton, NOAA
Mid-Atlantic Region Team Leader, SPOT

SUBJECT: Special Projects Operations Team (SPOT) Hydrographic Systems Status Summary

The hydrographic systems of the Special Projects Operations Team (SPOT) were reviewed in accordance with the Office of Coast Survey Field Procedures Manual (FPM) Hydrographic Systems Readiness Review procedures on March 29, 2007. The review process took place at Calvert Marina in Solomons, MD, and was conducted by a Hydrographic Systems Review Team comprised of the following people:

LTJG Briana Welton, Mid-Atlantic Region Team Leader
Caleb Gostnell, Physical Scientist, HSD Ops
Paul Turner, Physical Scientist, HSD Ops
Steve Brodet, Physical Scientist, HSTP

The Review Team’s findings are summarized in this memorandum and reflect the condition of the SPOT’s hydrographic systems on the review date. These findings have been divided into three categories of deficiencies:

CATEGORY 1 – These deficiencies indicate the failure or absence of vital equipment or preparations of systems essential to acquisition and/or processing of hydrographic data. The
HYDROGRAPHIC SYSTEMS READINESS REVIEW MEMO

vessel will be required to cease or limit hydrographic survey operations due to the following deficiencies:

1. The Special Projects Operations Team has a requirement for portable office space and at least two data processing computers with accompanying software. The office trailer is unequipped for mobile assignments and the unit has no processing machines. Currently the Team Leader is using Atlantic Hydrographic Branch office space and a laptop to process existing data, but the lack of dedicated processing machines makes efficient data manipulation and delivery nearly impossible.

CATEGORY 2 – These deficiencies indicate noncompliance with established policies, directives, instructions, or accepted hydrographic practice not addressed under Category 1. The following deficiencies shall be corrected in as timely a manner as funding, time, and/or professional assistance permit:

1. The vessel has only one mounting arm from which to deploy any one of the vessel’s three sonar systems: Reson 8125 multibeam echosounder (MBES), Light Weight Klein 5000 side scan sonar (SSS), and Benthos C3D interferometric sonar. A patch test must be performed each time one of these sonar systems is newly mounted before conducting hydrographic survey operations.

2. The port-side mounting arm was removed and the starboard side mounting arm was modified since the last NGS static offset survey. Since neither the length of the starboard arm or position of the cupped receptacle for the arm were altered, the surveyed benchmark stamp on the top of the arm is assumed to be the same as it was prior to modification. The offsets within the vessel frame of reference between the acoustic phase center of each sonar system and the benchmark on the top of the mounting arm have been manually measured with a steel tape. These manually measured offsets are used in the respective Caris HIPS/SIPS hydrographic vessel files (HVF). Resurvey of the mounting arm will be performed when possible.

3. A lead line comparison between the Reson 8125 multibeam, the Odom CV singlebeam, and the Benthos C3D interferometric sonar has never been performed. This comparison will be performed as soon as time and staffing allows.

4. Settlement and squat measurements have never been performed on this vessel. The current dynamic draft tables used in the system HVFs are from NRT 5 (s3002), a vessel of the same make and model. Settlement and squat measurements will be determined for this vessel as soon as time and staffing allows.
HYDROGRAPHIC SYSTEMS READINESS REVIEW MEMO

5. Isis 6.0 is currently being used for Reson 8125 and light weight Klein 5000 data acquisition. The software will be updated to the most recent version of Isis 7.0 when time and staffing allows.

CATEGORY 3 – items are associated with observations during the course of the review which merit consideration for corrective actions. These observations are included for review and dialogue related to potential problem areas and hydrographic operational efficiency. It is important to assure that resources (funds, skills, and time) are available at the operating level in order to meet the needs identified in this report and to sustain the efficient operation, upkeep, and repair of the field unit’s hydrographic systems.

1. The computer on which Hypack Max is used for navigation and singlebeam data acquisition exhibited serious boot errors on the date of review. The computer was sent to the Office of Coast Survey’s Hydrographic Support and Technology Program for analysis. A new hard drive and an updated operating system were installed to remedy the operating system boot problem. Since the update, the computer operates slower than expected for unidentified reasons.

2. The Digibar surface sound-velocimeter operates on battery power only, requiring weekly and/or daily battery renewal. Until a 12-volt power supply can be added to the Digibar, spare batteries must be carried aboard the vessel.

3. The vessel does not have a bottom-sampler, preventing the acquisition of bottom samples. Acquisition of a bottom-sampler should be considered.